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Information and statements contained in this and other
product documentation and help files are subject to change
without notice, and do not represent a commitment  on the

part of either FlashPoint Development or the author and
copyright holders.

The software described in this document is furnished under
various license or nondisclosure agreements.  The software
may be used, copied or distributed only  in accordance with
the terms of the applicable agreements.  Generally, unless

otherwise noted herein, the purchaser may make one copy of
the software for evaluation  purposes, and use same for a

period not to exceed thirty (30) days.  

Subject to the provisions concerning distribution of
unregistered evaluation or shareware copies, no part of the

software, documentation or related materials may be
reproduced or transmitted in any form or by any means,

electronic or mechanical, including photocopying and
recording, for any purpose other than the purchaser's

personal use without the written permission of FlashPoint
Development or the author and copyright holders.

See, the following topics in this User’s Guide, for additional information 
on:

“Legal Notices”

    “Proprietary Information”

    “Acknowledgments”

“License and Agreements”

See the following topics in the Product Catalog (ORDERME.DOC), for 
additional information on:

“How to Order and License Applications”

“Registered User Benefits, Support and Feedback”

“General Information”

“Individual Use (Per Copy) Licenses”

   “Fees and Charges”

   “Order Forms -- Individual Use (Per Copy) Licenses”

“Multiple Use (Site) Licenses”

    “Fees and Charges”

    “Order Forms -- Multiple Use (Site) Licenses”
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WELCOME

FlashPoint Development is proud to introduce and welcome you to the 
newest suite of file management applications in its Navigator ™ -- 
ZipTools ™ series -- FlashPoint UnZIP95 ™ for Windows Explorer.

Since the first public release of the original Navigator file manager for the
Zenith Z-100 computer and DOS, in 1984, FlashPoint Development has 
been committed to providing solutions to end user file management 
needs. without charge or at modest prices.  As always our ultimate goal 
is that the use of FlashPoint’s Navigator applications and utilities will 
make the day to day use of DOS and Windows a little more productive 
and, of course, a lot more fun.

UnZIP95 provides a new Windows Explorer subset of features of other 
FlashPoint Windows Navigator ZipTools’ utilities, and is designed to 
complement the latest releases of both third-party and FlashPoint 
Windows products, including Windows Navigator  ™ (WinNAV  ™), Zip 
Navigator  ™ (ZipNAV ™), ZipTools ™ for Windows and FlashPoint 
Zip/ZipX ™ -- the original one-hundred percent (100%) Windows 
implementation of ZIP archive, file compression, expansion, 
management and navigation utilities and the first ever to be distributed 
as shareware.

UnZIP95, together with Zip archive files, are essential tools for every 
individual and corporate user of Windows Explorer, who

Uses a modem for communications and e-mail, and wants to 
save time and reduce long distance toll charges; 

Accesses information or content on the Internet, a bulletin board 
systems ("BBS") or mainframe services, such as America 
Online, Microsoft Network or CompuServe, and desires to 
maintain e-mail privacy, file security and reduce online charges;

Desires to better organize and preserve file integrity, by placing 
multiple groups of files in single archives or libraries; or

Believes it is important to minimize valuable hardware and 
maintenance related costs, and that disk free space is and will 
continue to be a valuable resource. 

All of these goals can be accomplished through the use of UnZIP95 and 
other FlashPoint Navigator ZipTools.

For example, a Zip compressed archive file will generally be 50% to 70%
smaller than the aggregate size of its original member files; thus, one 
major and obvious benefit is that Zip file compression can save hard and
floppy disk space and significantly reduce related costs and expense.

The savings can be even more significant than the percentages above 
reflect, if a major weakness of the DOS file system is taken into 
consideration.  Although not readily apparent from a simple DOS file 
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directory listing, every individual file on a system's disk will consume a 
minimum amount of disk space no matter how little data, if any, appears 
to be contained in it; a file that appears to be only one (1) byte in length 
will actually consume or waste several hundred, if not thousands, of 
bytes of disk space.  Multiply this by even a modest amount of small 
files, and one can quickly see that consolidating small files in a single 
archive file, even without using any compression, can save hundreds of 
thousands of bytes of hard and floppy disk space.

However, there are other, not so obvious benefits, that can be achieved 
by using UnZIP95 and other Navigator ZipTools on a regular basis.

Using Zip archives can also reduce the number of individual files stored 
on a disk drive, by allowing the user to maintain combined groups of 
related files in a single library or archive file.  This can result in faster 
system response times by Windows based applications that would 
otherwise experience noticeable slowdowns each time they attempted to 
access scattered directories containing large numbers of individual, non-
archived files.  Fewer and faster disk accesses can help prolong the life 
of a system's drives, which in turn may result in lower repair and 
replacement costs.

Those who transfer files and e-mail by modem, to and from remote 
systems, will see immediate savings in long distance tolls and on-line 
service charges, which should be proportionately related to time saved 
by transferring a single, smaller, compressed Zip archive file, rather than 
several uncompressed individual files.  Using UnZIP95 will encourage 
users to download Zip archives rather than unarchived files, and allow 
even the most novice users to quickly access the contents of same.

No matter whether you are new to Zip archives and file compression or 
have been using those old DOS based ZIP utilities since their first 
introduction, if you use Microsoft Windows, Windows Explorer or 
Windows “My Computer” desktop application, you will certainly find 
unlimited benefits to be derived in upgrading to FlashPoint Windows 
UnZIP95.

The documentation and help files, distributed with the shareware and evaluation
version of this product, may contain information on features that are only

available in the registered version of the product.  Furthermore, the information
contained therein are subject to change without notice and do not represent a
commitment on the part of either FlashPoint Development or the author and
copyright holder to further develop or distribute any version of the product by

any means. 

The software described in this document is furnished under various license or
nondisclosure agreements.  The software may be used, copied or distributed
only  in accordance with the terms of the applicable agreements.  Generally,

unless otherwise noted herein, the purchaser may make one copy of the
software for evaluation  purposes, and use same for a period not to exceed

thirty (30) days.

Subject to the provisions concerning distribution of unregistered evaluation
copies, no part of the software, documentation or related materials may be

reproduced or transmitted in any form or by any means, electronic or
mechanical, including photocopying and recording, for any purpose other than

FlashPont Development



UnZip95 7

the purchaser's personal use without the written permission of the author and
copyright holder.
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FUNDAMENTAL CONCEPTS

Certain concepts and terms are often taken for granted by users, 
developers and documentation authors; however, each of their 
perspectives may be somewhat different.  It is important, therefore, to 
briefly review a few basics in order to insure that everyone has a 
common understanding of terms used in this documentation.

WINDOWS FOLDERS AND FILE 
DIRECTORIES

Although, with the advent of Windows 95, Microsoft began referring to 
DOS “file directories” as “folders,” this documentation uses the terms “file
directories,” “directories” and “folders” interchangeably.

WINDOWS EXPLORER AND “MY 
COMPUTER”

For purposes of this documentation, the reader should consider 
references to “Explorer” or the “Windows Explorer” shell to include 
references to the Windows’ “My Computer” desktop icon application.

The “My Computer” desktop icon is the basic (and Windows default) 
method to quickly and easily see almost everything on your computer. 
Simply, double-click the “My Computer” icon on the desktop to browse 
through your files and folders.

However, with the Windows Explorer interface, you can see both the 
hierarchy of folders on your computer and all the files and folders in each
selected folder. This is especially useful for copying and moving files. 
You can open the folder that contains the file you want to move or copy, 
and then drag it to the folder you want to put it in.  To run Windows 
Explorer, click the Start menu, point to the “Programs” item, and then 
click the “Windows Explorer” item on the popup submenu.

Both Windows Explorer and My Computer are part of the same Windows
shell, which itself is actually only a graphic user interface (GUI)  program 
or command shell that is loaded by Windows when it first starts up, e.g., 
you could easily change the default shell back to the Windows 3.1 
Program Manager user interface and give Windows the same look and 
feel as Windows 3.1.  By way of example, open My Computer select a 
disk drive or folder icon, click the file menu and select “Explore” -- the 
Window displayed is Windows Explorer.

Tip: Add a Windows Explorer shortcut to the desktop, and use it in 
place of the “My Computer” icon.

FlashPont Development
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FILE COMPRESSION AND ARCHIVES

Often terms such as "compression," "archives," "libraries" and 
"compacting" are used interchangeably when referring to file and media 
utilities, however, the terms are far from identical.

File Compression
Generally the term file "compression" refers to any method of reducing a 
single file's physical size, by varying degrees, and allowing it to be 
uncompressed at a later time without losing any of its essential 
characteristics.

The most obvious benefit is that a compressed file will occupy less 
space on a hard drive, disk, tape or other storage media.  Another 
benefit is that compressed files can be transmitted over wire, telephone 
or satellite in a shorter period of time than uncompressed files.

Many utilities and applications employ compression.  For example, many
software development companies now employ proprietary methods of 
compressing distribution files to reduce the costs of distribution disks and
their setup programs uncompress the files upon installation, and most 
popular graphics file formats are actually compressed data files.

The bottom line benefit is that using compressed files can directly or 
indirectly result in substantial savings of time and money.

Compacted and Compressed Files
While the concept of "compacting files" might include "compression," it 
also might include methods of permanently converting or modifying a 
file's essential characteristics.  That is to say, compacting would also 
include techniques for reducing a file's size, without providing any means
for the compacted file later to be restored to a mirror image of the 
original file.

This technique is more common to graphics files which do not require 
restoration to their original resolution.  For instance, their is little need to 
store files in a 600 dots per inch (dpi) format when they will only be 
reproduced, displayed or printed at 300 dpi.  Thus by converting the 
original files to a more compact lower resolution file, significant savings 
in storage space can result.

For purposes of this documentation we are not concerned with 
permanently "converting" files, we are concerned with temporarily saving
files in a compressed form for later retrieval.  Therefore, any references 
herein to compacting refers to the later and not the former.

Library and Archive Files
The term "libraries," as well as "archives," refers to file formats which 
combine groups of files in a single file; that is to say, groups of files are 
contained within a single library or archive file.
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"Library" files, at least when the term first became popular in personal 
computing with the advent of *.LBR files, referred to groups of 
uncompressed files; however, it was common for files to be compressed 
or rather "squeezed" by a standalone utility prior to being stored in a 
*.LBR file with a separate standalone library utility.

On the other hand, the term "archive" files, tended to refer to groups of 
compressed files after the advent of the once popular *.ARC file format.  
Thus, a single program was used to both compress and store multiple 
files in a single archive. 

FlashPoint's UnZIP95, as do FlashPoint’s other ZipTools and most third-
party Zip utilities, handle "zipped" files which are another form of 
"archive" files.  

Applications such as FlashPoint’s ZIP Navigator (“ZipNAV”) can be 
considered "archiver" programs, in that a single utility program first 
determines the optimum method, if any, for compressing a file, then 
compresses it, and finally stores or appends it to the archive or *.ZIP file.

UnZIP95, on the other hand is not an archiver, but can be used to 
expand, extract, view, open, list and otherwise manage existing zipped 
archive files.

Zip file compression can save significant disk space on most systems 
and allow faster data transfer to other systems, e.g., via modem; a 
compressed file will often be 50% to 70% smaller than its original size.

When this documentation refers to a "Zip" file or "zipfile," it refers to the 
main "archive" file.  References to "member" files are to the group of one
or more files stored within a Zip archive.  Hopefully, this will avoid 
confusion in trying to distinguish files that are "zipped" within an "archive"
from the “archive” file itself, e.g., a file having the “ZIP” file extension.

ARCHIVE AND COMPRESSION FORMATS 
-- A HISTORY

Over the years, numerous archive and compression formats have been 
employed in IBM compatible personal computing, and for non-DOS 
operating systems.

The Early Days
In the early days of CP/M, one popular compression method was 
"squeezing" files to create a file with the SQZ format; these files where 
then stored in a "library" file with the "LBR" extension.  Later developers 
came up with other, more efficient, compression and storage formats, 
some of which are still occasionally used today.

Users, with a modem who access the Internet, a computer bulletin board
system (BBS) or an on-line or e-mail service such as Microsoft Network, 
America Online, CompuServe, or who purchase shareware disks from 
various software vendors, may still occasionally come across archive 
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files with extensions such as LBR, LZH, LSH, LSZ, ARC and ARJ.  
However, they are more likely to find files having the “ZIP” file extension.

The ARC Wars
The most significant archive format, prior to the ZIP format becoming the
standard, was the ARC format developed by System Enhancement 
Associates, Inc. ("SEA").  However, the ARC format was abandoned by 
the BBS and on-line community almost overnight.

In an attempt to zealously protect its ARC utilities market and to keep the
ARC file format, the file extension "ARC" and even the term "archive" 
itself proprietary, SEA made a fatal mistake when it sued a shareware 
author named Phil Katz and PKWare, Inc., who had become SEA's 
biggest competitor after developing a set of more efficient ARC utilities.

Phil Katz and PKWare, Inc., having apparently decided that they could 
not afford to defend against the SEA lawsuit, were forced to enter into a 
settlement agreement which required them to abandoned their ARC 
utilities and code to SEA.  But what appeared to be a major victory for 
SEA, soon proved to be a nightmare -- Phil Katz and company didn't go 
away.

The BBS and on-line user community, justly or unjustly, became 
outraged at SEA, viewing it as the villain and Phil Katz as the underdog, 
and began to revolt.  When Phil Katz chose to develop a new, improved, 
better-than-ARC, set of DOS file compression and archive utilities, i.e., 
PKZip, the ZIP standard was born.  Within a few months, after some of 
the most heated on-line debates in the history of BBS and on-line 
computing, system operators ("sysops") across the country began 
converting all ARC files on their systems to the ZIP format, and the ARC 
file format began to fade into history.

FlashPoint Development Adds ZIP to Windows
Others, including FlashPoint Development, over the years have 
continued to enhance the use of the Zip archive format by creating 
utilities and applications for multiple operating systems and 
environments.  Zip utilities are now available for Amiga, Unix, MacIntosh,
OS/2 and many other host operating systems, and, more importantly, 
FlashPoint ZipTools, including UnZIP95, can handle Zip archive files 
created by all of them.

In the mid 1980’s FlashPoint Development introduced The Navigator ™ 
(also Windows Navigator ™ or WinNAV ™), which was the first 
commercially available Windows shell or file manager to support the 
DOS PKZip utilities.

In the late 1980’, FlashPoint, not being satisfied with merely shelling to 
DOS utilities under Windows, developed the first commercially available 
Windows Zip and UnZip command line utilities, FlashPoint Zip/ZipX.™  
Then, in the following years, introduced more advanced Zip utilities and 
user interfaces, including ZipTools ™ for Windows and Zip Navigator ™ 
(ZipNAV ™).  
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In 1995, FlashPoint introduced the first full-featured Windows 95 
Explorer Unzip utility, UnZIP95, which has become the most popular 
Windows Explorer add-on unzip utility available today.

Now, once again, FlashPoint raises the Zip standard to an even higher 
level under Microsoft Windows, with the introduction of the newest 
release of UnZIP95 for Windows Explorer.

So much for history.  The Zip archive and compression format is by far 
the most popular file compression format in use in the world today -- 
without question, it is the industry standard.

FlashPont Development
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GETTING STARTED

FlashPoint Windows UnZIP95 is a set of integrated Windows and 
Windows Explorer archive extraction utilities, which provide full file 
expansion, testing, listing and navigation tools for archives created in the
Zip compressed file formats.

INSTALLING FLASHPOINT WINDOWS 
UNZIP95

The shareware/evaluation version of FlashPoint Windows UnZIP95 files 
are originally distributed in a WinSFX ™ self-extracting archive named 
UNZIP95S.EXE.

The complete, licensed version of FlashPoint Windows UnZIP95 files are
either contained in a WinSFX tm self-extracting archive, named 
UNZIP95R.EXE, or are fully expanded on the registered user distribution
disk set.

To install the UNZIP95 files, simply run the WinSFX tm self-extracting 
archive, if the distribution files are contained therein, or run the 
SETUP.EXE program, if the distribution files are already fully expanded. 
Then follow the displayed instructions.

It should be noted that some shareware distribution points may have 
renamed or rearchived the UnZIP95 distribution files, placing them in a 
conventional archive, e.g., UNZIP95.ZIP or UNZIP95.LZH.  These 
archive formats will require a separate archive extraction utility to expand
the member files (such extraction utilities should generally be available 
from the same shareware distribution source).  To install UnZIP95, the 
user must first expand the files contained in such distribution archives to 
a temporary directory, and then run SETUP.EXE and follow the 
displayed instructions.

See, “Installation and Removal” for detailed instructions on both 
automated and manual setup, and uninstallation procedures.

Advanced UnZIP95 Configuration
Further installation and user customization can be performed through 
UnZIP95’s "Options" property sheet page controls, and the Windows 
Registration Database.

Note:  With the sole exception of the “Auto Close UnZip
Dialog on Process Completion” option, the “Options”
property sheet page features are not available in the

unregistered shareware, evaluation version of UnZIP95. 

In addition, other FlashPoint Windows applications and utilities, such as 
FlashPoint's Zip Navigator ("ZipNAV"), may provide menu and button 
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controls for access to their own “Options” dialog panels which allow 
modification of many default configuration settings; thereby avoiding 
having to enter command switches and parameters each time the 
applications are run.  UnZIP95 has been designed to work in conjunction
with such utilities, and may internally performs checks of their respective 
configuration files.

Refer to the “The Options Property Sheet Page” section, of the 
“UnZIP95 Features and Controls” chapter, in this documentation, for 
more detailed information on the “Options” controls.

Enhancing Windows System Configuration
Additional tips and suggestions, with respect to fine tuning UnZIP95 and 
the Windows environment, are provided throughout this documentation.

Also refer to the “Tips for Advanced Windows Users” section, for 
information on enhancing Windows system configuration with UnZIP95.

THE UNZIP95 TOOL SET

Zip archives created under any version of Windows, using FlashPoint 
Windows or Zip Navigators (WinNAV and ZipNAV) , under DOS, using 
PKZIP, or under DOS, OS/2, UNIX, Amiga and other operating systems,
using utilities of various third parties, can be tested, opened, listed or 
expanded by UnZIP95.

The Explorer Shell Extension
A Windows Explorer or My Computer shell extension dynamic link library
(UNZIP95.DLL) is provided as a part of the basic FlashPoint Windows 
UnZIP95 tool set.  When properly installed this utility adds advanced 
UnZIP95 Zip archive capabilities and features to the Windows Explorer 
and My Computer user interfaces.

Best of all, this interface provides a Completely Simple ™ solution for 
handling Zip archives under Windows -- so simple that the user doesn’t 
even need to run a traditional Windows “EXE” program.  Windows 
Explorer automatically loads and unloads UnZIP95 as needed.  All the 
user needs to do, to access an UnZIP95 function, is locate and select an
existing Zip archive in a Windows Explorer or My Computer folder, and 
RIGHT click the mouse button on it.

Custom Icons

Locating  a  Zip  file  in  a  Windows  Explorer  listing  or  My  Computer
directory folder is now easier than ever.  

The UnZIP95 Explorer shell extension provides new custom 
icons for file names with the "ZIP" file extension.  This allows 
the user to quickly identify archives when scanning a Windows 

Explorer listing or My Computer folder.
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Property Sheets

The UnZIP95 Property Sheet provides access to the basic and advanced
Zip archive capabilities that most Windows users will want.  

It provides a full Windows Explorer point and click user interface for the 
most used functions performed by the UnZIP95 executable, and even 
allows working with individual member files within the Zip archive.  

Unzip, list, examine, open, print, test or view one or more selected 
archive file members, without having to invoke a run command line or 
execute an external application program, and with absolutely no 
keyboard input.

To access the UnZIP95 property sheet dialog pages, simply (1) locate 
and select a standard “ZIP” file in Windows Explorer or My Computer, (2)
then click the “File” menu or click the RIGHT mouse button on the 
archive file, and (3) select the “Properties” menu item.

Context and File Menus

Of course, there may be times when a simple popup Windows context or
shortcut menu would be more efficient than accessing the UnZIP95 
property sheet dialog, e.g., to extract or test the integrity of all members 
of a highlighted archive.

For this reason, the UnZIP95 Explorer extension automatically adds new
command items to the Windows Explorer and My Computer “File” and 
popup shortcut menus which are displayed when a Zip archive is 
selected, for a Completely Simple ™ solution that is just a mouse click 
away.

To access an UnZIP95 “File” or popup shortcut menu feature, simply (1) 
locate and select a standard “ZIP” file in Windows Explorer or My 
Computer, (2) then click the “File” menu or click the RIGHT mouse 
button on the archive file, and (3) select the desired command item, e.g.,
the “Unzip,” “Check Integrity,” “Display Comments,” “About UnZIP95” or 
“Properties” menu item.

The FlashPoint UnZIP95 Executable
FlashPoint Windows UnZIP95 executable ("UNZIP95.EXE") is the 
Windows command line module used by UnZIP95 to perform its magic. 
It is compatible with all standard Zip archive files produced by current 
versions of FlashPoint's ZipTools, Zip Navigator ("UnZIP95"), Navigator 
and Windows Navigator ("WinNAV"), and ZIP/ZIPX utilities.  It is also 
compatible with PKWare's PKZIP utilities and ZIP file formats.

Like other FlashPoint Windows ZIPX utilities and the DOS PKUNZIP 
utilities, the UnZIP95 executable is strictly a command line application, 
and uses an optional parameter and switch syntax similar to their DOS 
counterparts

The UnZIP95 executable is an extraction or expansion utility.  It will list, 
extract, open, print or view member files contained in any standard or 
self-extracting Zip archive file, and test the compressed files integrity.  It 

FlashPont Development



UnZip95 16

will even recreate or build directories, which may be stored within a Zip 
archive file, and then expand member files to the appropriate directory.  
UNZIP95 can expand deflated, imploded, shrunk and stored files within 
all recognized versions of the Zip archive formats.

Most importantly, the UnZIP95 executable allows third-party developers 
and end-users to incorporate archive support into their own Windows 
applications, add shortcuts to the Windows desktop, folders, “Send To” 
and other menus, create customized file type associations and even use 
UnZIP95 as an Internet World Wide Web (WWW) browser “helper” 
application -- the possibilities are only limited by the user’s needs.
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QUICK START -- USING UNZIP95
.
FlashPoint’s “Completely Simple” UnZIP95 is not a traditional program,
but,  rather,  a  fully  integrated,  dynamically  invoked  extension  of  the
Microsoft Windows Explorer ("My Computer") shell.

STARTING UNZIP95

To start using UnZIP95, don't look for a traditional *.EXE file to run, or a
menu item or program icon to select in Explorer -- you won't find one!

There  are  no  programs  that  the  user  must  run  to  use  UnZIP95.
Windows Explorer (or “My Computer”) will automatically load and unload
UnZIP95 as needed.  

Just  open  Windows  Explorer,  locate  a  folder/directory  containing  an
existing Zip archive file (an archive file that has a “ZIP” file extension)
that you have created or downloaded, and RIGHT click your mouse on it.

LOCATING A ZIP ARCHIVE

Before you can work  with  an existing Zip  archive file  you created or
downloaded,  you must  be able  to  locate  it.   Locating a  Zip  file  in  a
Windows Explorer or My Computer directory folder should now be easier
than ever.  

If  UnZIP95 has been correctly  installed,  all  standard Zip  files
(those having “ZIP”  as the file  extension) will  be displayed in
Windows Explorer and My Computer as file folders with a zipper

overlaid.  If  they the “ZIP” file icons are not displayed this way, make
Explorer  the active window and press  the F5  function key to  refresh
Explorer and reload UnZIP95.

The  “ZIP”  and  other  filename  extensions  may  not  be  visible  on  all
systems.   This is because Windows Explorer and My Computer allow
users to enable or disable the display of filename extensions.  To see all
files and filename extensions:

1. In My Computer or Windows Explorer, open the
folder you want to look at.

2. On the View menu, click Options.

3. Click the View tab, and then click Show All Files.
If you want to see all filename extensions, make
sure the Hide MS-DOS File Extensions box is
not checked.

Most self-extracting Zip archives have an “EXE” file extension, and will
not  automatically  be  recognized  by  Explorer  as  true  Zip  archives;
however, this problem can be corrected by simply renaming the file to
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one with a “ZIP” file extension.  If  this is done Windows Explorer and
UnZIP95 will  treat  the newly renamed file  as a standard Zip  archive;
provided, the “EXE” file was really a self-extracting Zip archive -- there
are  other  types  of  self-extracting  archive  files  and  these  cannot  be
viewed by UnZIP95 even if their filename is changed to “ZIP” extension.

Tip: Many believe that  the practice of  renaming self-extracting Zip
archives,  whether  or  not  using  UnZIP95,  can  be an effective
means of reducing the risk of virus attacks from self-extracting
Zip archives created by unknown third-parties and downloaded
from the Internet or any online service.

To change the name of a file or folder

1. In  My  Computer  or  Windows  Explorer,  single
click the file or folder you want to rename. You
do not need to open it.

2. On the File menu, click Rename.

3. Type the new name, and then press ENTER.

Note,  under  current  versions  of  Windows,  a
filename  can  contain  up  to  255  characters,
including  spaces.  However,  it  cannot  contain
any of the following characters:

\  /  : * ? " < > |

Self-extracting Zip archives, with any file extension, can also be safely
unzipped using the popup and “File menus’ “Send To” file function, once
the  appropriate  shortcuts  have  been  created.   See,  the  “Adding
UnZIP95 Shortcuts” section of this document.

USING UNZIP95 -- THE BASICS

First,  select  (highlight)  a Zip  file  with your mouse,  and then click  the
RIGHT mouse button  or pull down the “File” option on the menu bar.

A popup context menu will be displayed with the basic UnZIP95 global
options from which you may select.  These include the “Unzip,” “Check
Integrity,” “Display Comments” or “About UnZIP95” menu items.

Additional, advanced features are available via a new tabbed property
sheet dialog that will be displayed by selecting the "Properties" menu
item on the “File” or popup context menu.  For a detailed description of
each  of  these  advanced  features,  refer  to  “The  UnZIP95  Explorer
Interface” and “Using the Explorer Property Sheets” sections of this
document.

To UnZip the Entire Archive

Click the “Unzip” item from the “File” or popup menu.
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A dialog will appear with an edit box, containing a suggested name for 
the directory folder to which the archive member files will be expanded.  

The user may accept the suggested name, or enter an alternate target 
folder/directory name -- either by manually typing an existing or new 
name into the edit box or by selecting an existing name from the 
“Directory Browser” that is displayed when the “Browse” button is 
clicked.  If the target folder does not exist, it will be automatically 
created.

When the desired target folder has been selected, simply click the OK 
button and the Zip archive member files, together with any internal 
directory structure, will be expanded.

To Check the Integrity  of the Entire Archive

Click the “Check Integrity” item from the “File” or popup menu.

A progress dialog will appear, showing the status of processing.  If the 
test is successful or if an error is detected, the appropriate message will 
be displayed.  A detailed summary of the test can be reviewed by 
clicking the “Review” button on the progress dialog.

The most common errors detected are when UnZIP95 is unable to locate
the end of the internal Zip archive directory.  Generally, this will mean 
that the Zip archive file is corrupted, e.g.,  this is may indicate that the 
file was truncated when a download prematurely terminated.

To Display the Archive Comment

Click the “Display Archive Comment” item from the “File” or popup menu.

A window will be opened to display the internal Zip archive comment, if 
any.  Generally, such comments are used to describe the contents of the
entire archive; however, adding archive comments are an optional 
feature used when creating a Zip file, and not all files will have them.

To Find Out More About UnZIP95

Click the “About UnZip95” item from the “File” or popup menu.

This will display a dialog box or window with information on the version of
the UnZIP95 utilities currently in use, as well as copyright, trademark and
other legal information.  The “About Box” will also display several buttons
that provide access to additional information, including how to license 
copies of UnZIP95, and to the UnZIP95 Help file.

See, the “About Dialogs” section of this document, for more detailed 
information on this feature.

To Work With Individual Member Files Within the 
Archive

Click the “Properties” item from the “File” or popup menu.  Then, when 
the multi-tabbed property sheet dialog is displayed, select the “Members”
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tab.  When the Members property sheet page is displayed, select the 
desired member files you wish to work with by highlighting their names in
the archive contents listbox, and click the appropriate command button.

See, “Using the Explorer Property Sheets” and “The Members 
Property Sheet Page” sections of this document, for detailed 
descriptions of the available Members property sheet page features and 
command functions.

To Customize UnZIP95’s Default Options

Click the “Properties” item from the “File” or popup menu.  Then, when 
the multi-tabbed property sheet dialog is displayed, select the “Options” 
tab.  When the Options property sheet page is displayed, modify the 
desired defaults using the appropriate dialog controls.

See, “Using the Explorer Property Sheets” and “The Options 
Property Sheet Page” sections of this document, for detailed 
descriptions of the available Options property sheet page features and 
command functions.

To Examine General Information on a Zip Archive or 
Change Its File Attributes 

Click the “Properties” item from the “File” or popup menu.  Then, when 
the multi-tabbed property sheet dialog is displayed, select the “General” 
tab.  When the General property sheet page is displayed, examine the 
displayed information on the archive file or modify the desired file 
attributes by checking or unchecking the appropriate dialog checkbox 
controls.

See, “Using the Explorer Property Sheets” and “The General 
Property Sheet Page” sections of this document, for detailed 
descriptions of the available General property sheet page features and 
command functions.

USING UNZIP95 -- ADVANCED FUNCTIONS

For a detailed description of each of these advanced features, refer to
“The  UnZIP95  Explorer  Interface,”  “Using  the  Explorer  Property
Sheets”  and  “The  UnZIP95  Executable  Module”  sections  of  this
document.

ADDITIONAL INFORMATION ON USING UNZIP95

Each  of  UnZIP95’s  features  are  fairly  straight  forward;  however,  for
additional information on using its features, refer to the online “Help” and
“About”  options,  and  the  documentation  files,  including  applicable
sections of this  User’s Guide, or visit FlashPoint Development’s World
Wide Web site where you will find helpful tips, updates and information
on UnZIP95 and other FlashPoint Windows products.
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To  optimize  UnZIP95's  “Properties”  dialog’s  advanced “Open,”  “Print”
and  “View”  features  on  your  system,  also  refer  to  the  applicable
Windows  shell  or  file  manager  application's  user  manual,  or  to  the
Microsoft Windows User Guide, for information on how to associate
files and use the Windows Registration Database.
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UNZIP95 FEATURES AND CONTROLS

THE UNZIP95 EXPLORER INTERFACE

Using the Explorer Shortcut and File Menus
The UnZIP95 popup context or shortcut menus can be displayed by 
selecting a valid Zip archive file in Windows Explorer or a My Computer 
folder, and then clicking the RIGHT mouse button.  The same command 
items are also available on the “File” menu when a Zip file is highlighted 
in a Windows Explorer or My Computer window.

From the popup or “File” menu, the user can select the following 
UnZIP95 commands:

Menu Item Description

Unzip Expands all member files in the archive to the 
designated target directory folder.

Check Integrity Checks or tests the integrity of the archive file and all 
member files contained therein.

Display 
Comment

Displays the comment or description, if any, of the 
archive.

About UnZIP95 Display the application's about dialog panel.  See, the 
“About Dialogs” section of this document, for more 
detailed information on this feature.

Properties Displays the UnZIP95 property sheet dialog.  See, 
“Using the Explorer Property Sheets.”

The Unzip Menu Command

The Unzip menu command expands all member files in the archive, 
together with their internal directory structure (if any),  to the designated 
target directory folder.

When this menu item is selected, the user is first prompted to confirm or 
modify the proposed target directory folder. The user may modify the 
proposed directory folder by directly typing in a new path or by using the 
“Browse” button.  See, “The Directory Browser” topic, below.

If the designated directory folder does not exist, it will automatically be 
created.

If the user clicks the “OK” button, UnZIP95 will proceed to unzip the 
selected archive’s contents to the designated directory folder.
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If the user selects the “Cancel” button, the unzip operation will be 
aborted.

The Directory Browser

The Directory Browser dialog panel contains the following controls:

Control Description

Selected Displays the drive and path name of the currently 
selected default directory, if it exists, or the current 
existing working directory.

Directory or 
Folder List

Displays the names of the (1) parent directory, (2) 
current directory, and (3) the child directories of the 
current directory.  To change to a new current directory, 
double-click the directory name icon or select it via the 
keyboard, and then chose the OK button or press the 
[ENTER] key.

Drive Displays the current system drive.  To change to a 
different drive, select the desired drive from the drop-
down list box.

Net Displays a Connect Network Drive dialog box allowing 
access to shared directories, if any.

This button is only functional on systems attached to 
networks supported by Microsoft Windows.

OK Selects the directory folder name displayed in the 
"Selected" edit control, and then closes the dialog box.

Cancel Closes the dialog box without selecting a directory.

The Check Integrity Menu Command

This item may be selected to check or test the entire archive’s integrity, 
to ensure that it has not been corrupted.

When selected, a progress dialog will appear, showing the status of 
processing.  If the test is successful or if an error is detected, the 
appropriate message will be displayed.  A detailed summary of the test 
can be reviewed by clicking the “Review” button on the progress dialog.

The most common errors detected are when UnZIP95 is unable to locate
the end of the internal Zip archive directory.  Generally, this will mean 
that the Zip archive file is corrupted, e.g.,  this is may indicate that the 
file was truncated when a download prematurely terminated.

The Display Comment Menu Item

This item may be selected to display the archive comment or description,
if any, that is stored in the archive file.

A window will be opened to display the internal archive comment, if any. 
Generally, such comments are used to describe the contents of the 
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entire archive; however, adding archive comments are an optional 
feature used when creating a Zip file, and not all files will have them.

The About UnZIP95 Menu Item

This menu command display the application's “About” dialog panel.  

The “About” dialog contains information on the version of the UnZIP95 
utilities currently in use, as well as copyright, trademark and other legal 
information.  This “About Box” also displays several buttons that provide 
access to additional information, including how to license copies of 
UnZIP95, and to the UnZIP95 Help file.

See, the “About Dialogs” section of this document, for more detailed 
information on this feature.

The Enhanced Properties Menu Item

If the “Properties” item from the “File” or popup menu is selected, a multi-
tabbed property sheet dialog will be displayed that provides access to 
many of UnZIP95’s advanced features.

See, the “Using Explorer Property Sheets” section of this document, 
for detailed information on using this dialogs advanced features.

Using the Explorer Property Sheets
The UnZIP95 Explorer Property Sheet Dialog might be considered the 
central command module for UnZIP95.

It can be used for various purposes, including changing archive file 
attributes, viewing a listing of the selected archive member files, together
with various technical information for each member and the archive itself,
and expanding, testing and opening all or any individual members.

UnZIP95 property sheets are displayed by selecting a valid archive name
in the Windows Explorer, clicking the right mouse button to access the 
context menu, and then selecting the "Properties" menu item.

The General Property Sheet Page

When the user selects a valid archive name in the Windows Explorer, 
clicks the right mouse button to access the context menu, and then 
selects the "Properties" menu item. the UnZIP95 General Property Sheet
is displayed.

The General Property Sheet controls are logically ordered, and consist of
the following controls:

Control Description

Archive Displays the name of the archive file, and the assigned 
icon.

Type Displays the selected file type.
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Location Displays where the file is located on the user's 
computer.

Size Displays the size of the file.

MS-DOS name Displays the name of the file in DOS format.

Created Displays the date the file was created.

Modified Displays the date the information within the file was last 
changed.

Accessed Displays the date the file was last accessed or opened.

Attributes Displays some of the current file system attributes for 
the selected file.

     Read-Only Shows whether the file is read-only, which means it 
cannot be changed or accidentally deleted.

Click the checkbox control to toggle this file attribute on 
or off.

     Hidden Shows whether the file is hidden, which means it cannot 
generally be seen or used unless the name is known to 
the user.

Click the checkbox control to toggle this file attribute on 
or off.

     Archive Shows whether the file has been archived (backed up); 
the term "archive" refers to a general file attribute and 
has no relationship to the fact that this is a ZIP archive 
file.  Some programs use this attribute to show whether 
or not a file has been backed up.

Click the checkbox control to toggle this file attribute on 
or off.

     System Shows whether the file is system file.  System files are 
generally required by the operating system or 
environment in order to run properly, and by default are 
not shown in folder or directory listings.  System files 
should not normally be deleted.

Click the checkbox control to toggle this file attribute on 
or off.

OK Accept any modifications, and exit the property sheet 
dialog.

Cancel Abandon any modifications, and exit the property sheet 
dialog.

Apply Saves any modifications, without closing the property 
sheet dialog.

Help Execute the Windows Help utility and display the 
application's help file.
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The Members Property Sheet Page

Once the UnZIP95 property sheet dialog is visible and the user selects 
the "Members" property sheet tab, the UnZIP95 Members Property 
Sheet is displayed.

Note:  The “Print” and “View” button functions are not
available in any unregistered shareware, evaluation

version of UnZIP95; however, such features are similar
to the “Open” function that may be available in some
releases of the unregistered shareware, evaluation

version of the program. 

The "Members" page displays the name of the selected "Archive" -- 
together with a listing of its member files and other related information in 
the "Member List" and "Status Window" controls.  If the name of an 
invalid or nonexistent archive file is entered, the "Status Window" will 
display the appropriate error information.  If required, the information 
contained in these list boxes may be scrolled, e.g., to display all member
files, together with their uncompressed size, the date and time of 
creation or last modification and other related information.

The Member Property Sheet controls are logically ordered, and consist 
of the following controls:

Control Description

Archive The "Archive" file control, contains the name of the 
active archive.

Member List Displays listing of the member files within the selected 
archive.  The user may select all or any individual files in
this list for additional processing.  The Select/Unselect 
push button control, the shift, keyboard arrow 
combination and left mouse button is used for marking 
selected files.

Status Window Displays information on the selected archive and its 
contents, and also provides additional information on 
error results and other functions.

Unzip To -- 
Target 
Directory or 
Folder

This control group displays the target directory or folder 
that will be used for processing, e.g., the directory to 
which member files will be expanded if the "Unzip" push 
button is selected.  The default directory or folder will be 
the same as the specified archive (without the archive 
file extension).

The user may change the default setting by directly 
editing the target name in the edit box, or by using the 
"Directory Browser" dialog panel that can be displayed 
by selecting the "Unzip To" push button control.

Select / 
Unselect

Toggles the selection (high lighted) status of the member
files.

When any files are selected in the member listbox, this 
control becomes the "Unselect" button.  Selecting this 
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control will unselect or clear all selected (highlighted) 
items in the member listbox.  The action button controls, 
e.g., UnZip, Check, Info, Open, etc., are disabled and 
grayed.

When no files are selected in the member listbox, this 
control becomes the "Select" button.  Selecting this 
control will select (highlight) all items in the member 
listbox.  The action button controls, e.g., UnZip, Check, 
Info, Open, etc., are enabled.

UnZip Expand the selected member files from the archive to 
the target ("Unzip To") directory folder.

Check Check the integrity of the selected member files.

Info Display the ZIP Info dialog box, which provides detailed 
information on the selected member files.

Open The Open button control runs or loads the selected 
member files, with the most appropriate user application 
program available.

UnZIP95 first attempts to use Windows file type or 
association features, to determine the most appropriate 
user application with which to open the file.  If UnZIP95 
cannot locate any associated application program, it 
defaults to (1) the “Open” utility program designated by 
the user on the “Options” property sheet page, (2) 
Windows WordPad, or (3) Windows Write.

Note:  Open, Print and View expand the selected file to 
a temporary directory, and then loads it into the 
appropriate application program.  When the user closes 
the application program, UnZIP95 deletes the extracted 
file from the temporary directory.

Print The Print button control loads the selected member files 
into the most appropriate user application program 
available, and attempts to invoke the programs File Print
command.

UnZIP95 first attempts to use Windows file type or 
association features, to determine the most appropriate 
user application with which to print the file.  If UnZIP95 
cannot locate any associated application program, it 
defaults to (1) the “Print” utility program designated by 
the user on the “Options” property sheet page, (2) 
Windows WordPad, or (3) Windows Write.

Note:  Open, Print and View expand the selected file to 
a temporary directory, and then loads it into the 
appropriate application program.  When the user closes 
the application program, UnZIP95 deletes the extracted 
file from the temporary directory.

View The View button control displays the selected member 
files, with the most appropriate user application program 
available.

UnZIP95 first attempts to use Windows file type or 
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association features, to determine the most appropriate 
user application with which to view the file.  If UnZIP95 
cannot locate any associated application program, it 
defaults to (1) the “View” utility program designated by 
the user on the “Options” property sheet page, (2) 
Windows WordPad, or (3) Windows Write.

Note:  Open, Print and View expand the selected file to 
a temporary directory, and then loads it into the 
appropriate application program.  When the user closes 
the application program, UnZIP95 deletes the extracted 
file from the temporary directory.

About Display the application's about dialog panel.  See, the 
“About Dialogs” section of this document, for more 
detailed information on this feature.

How do I 
register ...

Provides access to information on how to purchase 
registered, licensed copies of this product -- including 
price lists and order forms.  This push button control only
appears in non-registered or evaluation versions of the 
product.

OK Accept any modifications, and exit the property sheet 
dialog.

Cancel Abandon any modifications, and exit the property sheet 
dialog.

Apply Saves any modifications, without closing the property 
sheet dialog.

Help Execute the Windows Help utility and display the 
application's help file.

The Zip "Info" Button Dialog

If the user selects the "Info" push button control on the "Members" 
property sheet, after selecting the desired member files in the member 
listbox, the UnZIP95 Zip Info Dialog panel is displayed.

The Info Dialog allows the user to view detailed technical information on 
each of the selected archive member files.

The Info Dialog panel controls are logically ordered, and consist of the 
following:

Control Description

Information 
Window

Displays detailed information on each of the archive 
member files selected in the "Members" property sheet 
member listbox.

Next Advances the view window to the next selected archive 
member file.  If no more selected files are available, this 
control is grayed.

Cancel Exits the Info Dialog, and returns to the "Members" 
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property sheet page.

The "Unzip To" Button -- Directory Browser

The "Directory Browser" allows the user to scroll through all drives and 
directory folders available on his or her system, in order to locate the 
desired directory or folder name to be entered into the associated "Unzip
To" edit box.

Once the appropriate drive and path appears in the "Selected" window, 
all that the user needs to do is click on the "OK" push button and the 
"Selected" folder name or pathspec, i.e., drive with directory appended, 
will be entered into the "Unzip To" property sheet edit control.

To quit or close the "Directory Browser" without changing the original edit
control, the user can either click on the "Cancel" push button or press 
the keyboard [Escape] key.

The Directory Browser dialog panel contains the following controls:

Control Description

Selected Displays the drive and path name of the currently 
selected default directory or folder, if it exists, or the 
current existing working directory.

Directory List Displays the names of the (1) parent directory, (2) 
current directory, and (3) the child directories of the 
current directory.  To change to a new current directory, 
double-click the directory name icon or select it via the 
keyboard, and then chose the OK button or press the 
[ENTER] key.

Drive Displays the current system drive.  To change to a 
different drive, select the desired drive from the drop-
down list box.

Net Displays a Connect Network Drive dialog box allowing 
access to shared directories, if any.

This button is only functional on systems attached to 
networks supported by Microsoft Windows.

OK Selects the directory name displayed in the "Selected" 
edit control, and then closes the dialog box.

Cancel Closes the dialog box without selecting a directory.

The Options Property Sheet Page

Once the UnZIP95 property sheet dialog is visible and the user selects 
the "Options" property sheet tab, the UnZIP95 Options Property Sheet 
Page is displayed.
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Note:  With the sole exception of the “Auto Close UnZip
Dialog on Process Completion” option, the “Options”
page features are not available in the unregistered

shareware, evaluation version of UnZIP95. 

The Options Property Sheet Page controls consist of the following::

Control Description

UnZip Default Settings:

Auto Close UnZip Dialog 
on Process Completion

If checked, the UnZIP95 executable 
application, which displays the 
progress dialog, will automatically close
on completion of processing.

If not checked, the UnZIP95 executable
application will not be automatically 
closed, and the progress dialog will 
remain visible until the user manually 
closes it.

Restore Directory 
Structure

If checked, the internal file member 
directory structure stored within the 
archive, if any, will be recreated or 
restored. 

If not checked, the internal directory 
structure, if any, will be ignored and all 
member files will be expanded to the 
target directory folder.

Restore Volume Label If checked, a volume label stored within
the archive, if any, will be recreated on 
or restored to the target disk, i.e., the 
target disk will be relabeled to the 
internally stored volume name.  This 
feature only applies to removable 
drives, e.g., floppy disks -- hard drives 
will not be relabeled.

If not checked, volume labels stored 
within the archive, if any, will be 
ignored. 

Do Not Prompt Before 
Overwrite

If checked, UnZIP95 will not prompt the
user before overwriting any existing 
files in the target directory folder that 
have names identical to the archive file 
members being expanded.

If not checked, UnZIP95 will always 
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prompt the user before overwriting any 
existing files in the target directory 
folder that have names identical to the 
archive file members being expanded.  
In addition, when prompted, the user 
may chose to extract the file anyway, 
rename it to a new name in the target 
directory folder, or skip the file and 
continue or abort processing.

Beep On Toggles UnZIP95’s beep on and off.

Convert Text File End-of-
Line (EBCDIC to ASCII)

If checked, any member text files, that 
are being extracted, opened, printed or 
viewed, will have their end-of-line 
characters converted, if required, from 
EBCDIC to ASCII format.  This can me 
extremely helpful when working under 
DOS or Windows, with text files 
originally created under Unix, 
MacIntosh or other host operating 
systems.

If not checked, no end-of-line 
conversion takes place.

Warning:  This feature relies on 
internal Zip file directory information to 
determine if the file being extracted and
converted is a text rather than a binary 
file -- binary files, such as programs, 
would be corrupted if converted in this 
fashion.  Some popular third-party Zip 
archivers do not properly mark or flag 
the member files as text or binary when
creating the original archive, and, 
therefore, it may be necessary to select
member files from such archives for 
processing on a file by file basis.

Use Quick View file 
viewers

If checked, the Members property sheet
page “View” button feature will use 
Windows Quick Viewers as the 
exclusive view utility with which to 
display files.

If unchecked, the appropriate View 
utility will be determined internally by 
UnZIP95.

Warning:  Some versions of Quick 
View fail to completely remove itself 
from memory, upon termination and 
closing of the viewer window.  This will 
cause UnZIP95’s internal file 
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processing to also remain in memory, 
waiting to be notified that the Quick 
View application has terminated, and 
prevent viewing of additional files.  To 
clear Quick View from memory, press 
the Ctrl+Alt+Delete key combination, 
locate and select “Quick View” in the 
“Close Program” dialog, and click the 
“End Task” button.  If you experience 
this problem, it is recommended that 
you do not enable the “Use Quick View 
file viewers” option.

Default utilities

Open Allows the user to assign the preferred 
default utility with which to “Open” files 
from the Members property sheet page.

Print Allows the user to assign the preferred 
default utility with which to “Print” files 
from the Members property sheet page.

View Allows the user to assign the preferred 
default utility with which to “View” files 
from the Members property sheet page.

Warning:  Some applications, such as early versions of Quick View 
and program modules such as Windows95 WRITE.EXE which actually 
spawn secondary applications, may fail to completely remove 
themselves from memory, upon termination and closing of the spawned
applications main window.  This will cause UnZIP95’s internal file 
processing to also remain in memory, waiting to be notified that the 
original application has terminated, and may prevent the loading of 
additional files using the same utility.  To clear such applications from 
memory, press the Ctrl+Alt+Delete key combination, locate and select 
the offending application in the “Close Program” dialog, and click the 
“End Task” button.  If you experience this problem, it is recommended 
that you use an alternate utility program.

Save and Restore Settings

Reset Restores the previously saved option 
settings.

Save Saves the current option settings as the
new default.

OK Accept any modifications, and exit the 
property sheet dialog.

Cancel Abandon any modifications, and exit 
the property sheet dialog.
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Apply Saves any modifications, without 
closing the property sheet dialog.

Help Execute the Windows Help utility and 
display the application's help file.

The "Browse" Button -- File Browser

The "File Browser" allows the move through all drives, directories and 
folders accessible to or available on his or her system, in order to locate 
the application program to be entered into the appropriate Default Utility 
edit box.

Once the desired application program’s filename appears in the selected 
folder window, all that the user needs to do is select (highlight) the 
application name and click the "OK" push button.  The full path and 
filename for the selected file will be entered into the appropriate Options 
property sheet page edit control.

To quit or close the "File Browser" without changing the original edit 
control, the user can either click on the "Cancel" push button or press 
the keyboard [Escape] key.

The File Browser dialog is similar to the standard Windows “Save As” 
dialog panel, and contains the following controls:

Control Description

Save in Displays the drive, path or folder name of the currently 
selected folder.

File and  
Directory  
Folder List

Displays an icon and the names of the file names and  
child directory folders of the current directory folder.  To 
change to a new current directory, double-click the 
desired directory folder name, or select it via the 
keyboard, and then chose the OK button or press the 
[ENTER] key.

File Name Displays the name of the selected file, if any. To change 
to a different file name, select the one desired from the 
file and directory list box.

Net Displays a Connect Network Drive dialog box allowing 
access to shared directories, if any.

This button is only functional on systems attached to 
networks supported by Microsoft Windows.

Save As Selects the file name displayed in the "File Name" edit 
control, and then closes the dialog box.

Cancel Closes the dialog box without selecting a file name.
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THE UNZIP95 EXECUTABLE MODULE

FlashPoint Windows UnZIP95 executable (UNZIP95.EXE) is a command
line utility.  It is designed to be invoked or launched by external 
applications and procedures, such as the UnZIP95 context menu and 
property sheets, and its functions are controlled by means of command 
line parameters and switches.

Thus, UNZIP95.EXE may be invoked by the standard "run" or "launch" 
command prompts, available in most Windows shells, such as Explorer's
Start menu, and Program and File Managers, or, by more elaborate 
means, through the use of user developed applications and macros.

During processing UNZIP95.EXE may display various dialog boxes 
which prompt the user for additional information.

Basic Command Line Structure
The basic command line format for FPZIP and FPZIPX can be broken 
down as follows:

appname.exe -switches zipname[.zip] parameters -D targeet -
x filespecs

Parameter Description

appname.exe The application name, UNZIP95.EXE, with or without 
the full drive and path specifications, depending on 
whether or not the application file resides in the current 
working directory or one specified in the system 
environment's path statement.

-switches One or more action or option command switches.

A primary switch is always preceded by a minus sign, 
but may be followed by optional secondary switches 
which may not require a preceding minus sign.

With one exception, i.e., the FPZIP exclude file switch 
(-x filespecs), switches are always located in the 
command line before the ZIP file name.

zipname.zip A filename, including drive and path specs, for the 
compressed ZIP file to be created, modified or operated 
on.  The ".ZIP" extension will be added if no file 
extension is specified.

parameters Generally path or file specs for directories and files to be
included in or excluded from the ZIP file operation, and 
may include DOS wild card characters, e.g., the "*" and 
"?" characters.

The first series of path or file specs to follow the ZIP file 
name identify the files to be operated on, added to or 
extracted from the archive.  All files in a specified 
directory are processed, unless a filespec is provided to 

FlashPont Development



UnZip95 35

specify a subset of the files within the directory.

If multiple filespecs are used, the user must insure that 
the total length of the command line does not exceed the
maximum characters permitted under the underlying 
operating system, e.g., originally DOS command lines 
were limited to 128 characters but current versions 
Windows has expanded this to 260 characters; the user 
may prefer to add all the file names to a single batch file.

A batch file is simply a text file listing each filespec on a 
separate line, with each line ended with a return.  A 
batch file is identified on the command line by preceding 
its name with an '@' symbol.  For example:

unzip95  zipfile  @mylist.txt

will expand all files referenced by the filespecs contained
in the batch file "mylist.txt"  which are member files in 
the ZIP archive file named "zipfile.zip."

-D target In the UNZIP95.EXE command line, a "target" directory 
or folder may follow the ZIP file name.  This identifies the
"unzip directory" where the ZIP file members are to be 
extracted to and expanded.  This target directory must 
be preceded by the "-D" option switch.

-x filespecs The exclude file switch, which may be considered a 
parameter of sorts, is the last item that appears on the 
command line for the UNZIP95.EXE application.

A description, of the actual command line syntax, parameters and 
switches can be displayed by executing one of the following "Run" 
commands:

unzip95.exe  -?
unzip95.exe  -h

from the Windows "Start" menu, or the Windows File or Program 
Manager "File" menu “Run” command.

A detailed description and explanation of the actual
command line syntax, parameters and switches, appear

in the registered version of this product.

Main Display Options
The UNZIP95.EXE command module can display alternate combinations
of windows, during and after processing.

The Progress Dialog

When this window feature is enabled a progress dialog window is 
displayed during processing.  This is the window is identical to the one 
displayed during most UnZIP95 processing.
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The progress dialog tracks the status of the current files being 
processed, and provides user access to the following controls:

Control Description

Archive Displays the name and path of the current archive being 
processed.

Progress 
Indicators

Displays a visual status of archive and member 
processing through the use of text and graphic 
indicators.

Help This push button control, displays the application's about
dialog panel, which allows access to additional 
information on the product and the application's 
Windows help file.

View / Review Displays the TTY window, if not visible, and closes the 
progress window.  Generally, the TTY window provides 
more detailed information on the processing of the files 
than does the Progress Dialog.

During processing this push button control is labeled 
"View."  Upon completion of processing the button is 
labeled "Review."

The primary functions of the TTY window is to allow the 
user to view/review processing of the selected files, and,
if desired, to save the TTY window contents to a text file.

Abort Terminates processing of the archive.  This push button 
control is only visible during actual processing.

Exit Closes window and exits application.  This push button 
control is only visible after actual processing has 
completed.

The TTY Window

When this feature is enabled a standard frame and client (TTY) window 
is displayed during processing, rather than the progress dialog.  This is 
also the same window that is visible when the user clicks the “View” or 
“Review” button on the progress dialog.

In this main TTY window, the user has access to the following menu 
items:

Control Description

File Menu

Abort Terminates processing of the archive.

Exit Closes window and exits application.

Edit Menu

Save Buffer Displays the "Save To File" dialog box, which allows 
all text displayed in the client window's buffer to be 
saved to a text file.
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Help Menu

Contents Displays the "Contents" topic, which is the first topic 
in the Help file.

Search for 
Help on ...

Displays the "Search" dialog box

How to Use 
Help

Displays the Windows How To Use Help file in a new
Help window.

How to 
Register

This push button control, executes the Windows Help
utility, loads the application help file, and displays 
information on how to purchase a full registered 
version of this product.  Applicable order forms may 
be printed from the help file.

This menu item only appears in non-registered 
versions of the product.

About ... Display the application's about dialog panel.  See, the 
“About Dialogs” section of this document, for more 
detailed information on this feature.

The Overwrite Dialog
If an existing file in the target directory or folder has the same file name 
as a member file about to be extracted from an archive, the user is 
prompted as to whether or not the existing file should be overwritten by 
the extracted file.

A dialog panel is displayed, presenting several extraction options not 
generally found in other ZIP expansion utilities.  The user can designate 
what action should be taken, by selecting one of the following controls:

Control Description

Yes If this push button is selected, the existing file will be 
overwritten by the member file being extracted.

UnZIP95 will continue the processing of the "Unzip" 
command, and continue to prompt the user before 
overwriting other existing files.

No If this push button is selected, the existing file will not be 
overwritten, and the current member file will not be 
extracted.

UnZIP95 will continue the processing of the "Unzip" 
command, and continue to prompt the user before 
overwriting other existing files.

All If this push button is selected, the existing file will be 
overwritten by the member file being extracted.

All subsequent prompts to overwrite other existing files 
will be disabled, and all duplicate files will thereafter be 
automatically extracted from the archive.  UnZIP95 will 
continue the processing of the "Unzip" command.
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None If this push button is selected, the existing file will not be 
overwritten by the member file being extracted.

All subsequent prompts to overwrite other existing files 
will be disabled, and no duplicate files will be 
overwritten.  Thus, any duplicate archive member files 
will be ignored and not extracted.  UnZIP95 will continue
the processing of the "Unzip" command.

Rename If this push button is selected, the "Rename File" dialog 
is displayed, which allows the user to designate a new 
name for the file to be extracted.  See, the "Rename File
Dialog" topic, for additional information.

Upon extraction of a renamed file, UnZIP95 will continue
the processing of the "Unzip" command, and continue to 
prompt the user before overwriting other existing files.

Cancel If this push button is selected, the existing file will not be 
overwritten by the member file being extracted.

UnZIP95 will terminate processing of the "Unzip" 
command.

Rename File Dialog

When the an archive member file is about to overwrite an existing file in 
the target directory or folder that has the same file name, an overwrite 
dialog prompt is displayed.  One option the user may select is the 
"Rename" push button -- this option then displays the Rename File 
dialog panel.

The Rename File dialog allows the user to rename the member file to be 
extracted, thus avoiding overwriting of the existing file while still allowing 
the member file to be extracted.  UnZIP95 will continue to process the 
current "Unzip" command, and continue to prompt before overwriting any
other existing files.

This avoids the common dilemma, presented by many ZIP expansion 
utilities, of either (1) having to terminate the extraction processing, 
renaming or moving the existing file, and then restarting the extraction 
process from scratch, or (2) overwriting the existing file and losing its 
data forever.  This dilemma is most common for ZIP archives that 
contain "readme" or "readme.txt" member files.

The Password Dialog
Often ZIP archives and their members are password encrypted, which 
means the user will be denied access unless he or she knows the proper
password.

When such an encrypted file is encountered by UnZIP95, a Password 
Dialog will be displayed, requesting that the user enter the required 
information.
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Control Description

Password Edit box for entry of required password.

As the user enters each character of the password an 
asterisk "*" is displayed in the password edit box -- this 
prevents others from viewing or intercepting the 
password the user is entering.

OK Save password, and return to the previous window.

Skip Ignore password entry, skip the current password 
encrypted file, and continue processing the remaining 
file members.

Cancel Ignore password entry, and terminate processing of the 
remaining file members.

Once the user enters the correct password, processing will continue on 
the current password encrypted member file.

If UnZIP95 encounters another password encrypted member file during 
the current processing session, it will first attempt to use the last 
password entered by the user; if this is the correct password, processing
will continue without further user input.  If this is not the correct password
for the current file, the user will be again prompted to enter the correct 
password.  Although not often encountered, the ZIP archive file format 
allows each archive member to have a unique password; thus, multi-
password archives will require the user to enter multiple passwords.

ABOUT DIALOGS

The application's "About" dialog panel provides various legal, license and
"how to order" information, with respect to the product, through the 
following controls:

Control Description

Order Info This push button provides access to on-line information 
screens that display basic information on how to order, 
register and license this application.  See, "Order Info 
Panels."

Acknowledgem
ents

This push button control, executes the Windows Help 
utility, loads the application help file, and displays the 
Acknowledgments topic of the file.  See, 
"Acknowledgments"

Help This push button control, executes the Windows Help 
utility, loads the application help file, and displays the 
help index.

How to 
Register

This push button control, executes the Windows Help 
utility, loads the application help file, and displays 
information on how to purchase a full registered version 
of this product.  Applicable order forms may be printed 
from the help file.

Exit Exit this application.
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Continue Return to the main application window, and continue.

Order Info Panels
There are several on-line information screens that display basic 
information on how to order, register and license the application as well 
as providing access to the online help file.

An additional Phone and Credit Card Orders information screen may 
be accessed from the initial Information dialog panel by selecting the 
appropriate push button.

Selecting the "Continue" push button on either the initial or secondary 
Information dialog panels will return the user to the "About" dialog.

More detailed information, on licensing this and other FlashPoint 
Development applications, is set forth in UnZIP95 Product Catalog 
(ORDERME.DOC) and help files provided in the distribution packages.

HELP

Microsoft Windows online Help provides a quick, convenient way to look 
up information about the application and its use, and is available from 
within the application whenever a Help command button or menu item is 
displayed.  When the application's Help file is loaded, various menu and 
control button may be used for easy access to many Help features.

The basic button controls used by the application help file provide access
to commonly used Help functions.  These button controls may vary 
between versions of the Microsoft Windows help file viewer, but 
generally include the following:

Control Description

Contents Displays the "Contents" topic, in a secondary window.

Index Displays the "Index" dialog box

Back Jumps to the last topic the user displayed in the main 
window.

History Displays the "History" window.

<<  (Browse 
Previous)

Jumps to the previous topic in the browse sequence

>>  (Browse 
Next)

Jumps to the next topic in the browse sequence

Print Prints the topic displayed in the main window.  Note: 
This button is not available in unregistered evaluation 
versions.
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Close Closes both the main and secondary help windows.  
Performs same function as the "File" menu "Exit" item.

The main window of the help file viewer also, generally, displays multiple 
drop-down menus containing most of the following menu items.

Control Description

File Menu

Open Displays the Open dialog box.

Print Topic Prints the topic displayed in the main window.  Note: 
This function is not available in unregistered evaluation 
versions.

Print Setup Displays the Print Setup dialog box.

Exit Closes both the main and secondary help windows.  
Performs same function as the "Close" button.

Edit Menu

Copy Topic Displays the Copy dialog box, and allows the displayed 
topic to be copied to the clipboard.  Note: This function is
not available in unregistered evaluation versions.

Annotate Displays the Annotate dialog box.

Bookmark Menu

Define Displays the Bookmark Define dialog box.

List List the first nine bookmarks defined in the Help file.  
These items are displayed only if bookmarks are 
defined.

More Displays the Bookmark dialog box for Help files that 
have more than nine bookmarks defined.  This item is 
displayed only if ten or more bookmarks are defined..

Help Menu

How to Use 
Help

Displays the How To Use Help file in a new Help 
window.

Always On 
Top

Displays all Help windows on top of other application 
windows.

About Displays the About Dialog box.

For a more detailed explanation of the Windows Help application and its 
usage, review the "Help" menu "How To Use Help" item and the 
Microsoft Windows User's Guide.
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TIPS FOR ADVANCED WINDOWS USERS

WINDOWS SYSTEM CONFIGURATION

The Windows associate or file type capabilities, and shortcuts can be 
used to further enhance the use of UNZIP95 applications.

File Association and Types
When individual ZIP file members are opened, printed or viewed, by 
clicking the Open, Print or View buttons on the “Members” page of the 
Windows Explorer or My Computer shell property sheet, UnZIP95 will 
first attempt to execute any associated file type’s application program 
and, if successful, load the selected member file for processing.

Creating a file type is similar to associating a file in Windows version 3.1,
but you can specify actions for more than just opening the file; for 
example, you can specify which program should be used for printing the 
document.

To create a new file type or file association:

1. Double-click the My Computer icon, or start 
Windows Explorer.

2. On the View menu, click Options, and then click 
the File Types tab.

3. Click the New Type button.

4. Specify a description for the file type and the 
filename extension associated with this type of 
file.

5. Click New to define an action for this file type.  

6. Specify the action that you want to define, such 
as Open or Print, and the program command 
that should run to complete this action.

7. Repeat steps 5 and 6 for as many actions as 
you want to define for this file type.

To modify an existing file type or file association:

1. Double-click the My Computer icon, or start 
Windows Explorer.

2. On the View menu, click Options, and then click 
the File Types tab.
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3. Click the file type to be modified -- the settings 
for that file type are shown in the File Type 
Details box.

4. Click Edit.

5. Change the description for the file type and the 
filename extension associated with this type of 
file, if desired.

6. Click the command in the Action box that you 
want to modify, such as “open,” and then click 
Edit.

7. Specify the action that you want to define, such 
as Open or Print, and the program command 
that should run to complete this action.

8. Repeat steps 6 and 7 for as many actions as 
you want to modify for this file type.

Refer to the applicable shell or file manager application's user manual or 
to the Microsoft Windows User Guide, for more information on how to 
associate files and use Windows file type capabilities.

Adding UnZIP95 Shortcuts
You can use the UnZIP95 Executable (UNZIP95.EXE) and Windows 
shortcuts as a fast way to unzip an archive from other applications and 
shells, such as the Windows File Manager and many popular World 
Wide Web Browsers..

Desktop Shortcuts

To put a shortcut UNZIP95.EXE on the desktop

1. Open My Computer or Windows Explorer, and 
locate the folder that contains UNZIP95.EXE.

2. Click the UNZIP95.EXE program file -- when 
selected the icon and name will be highlighted.

3. On the File menu, click Create Shortcut.

4. Drag the shortcut icon onto the desktop.

To change any settings for the shortcut, such as adding 
a command line switch to specify the target folder to 
which files are to be expanded, what kind of window it 
starts in or what key combination is used to access it, 
use your right mouse button to click the shortcut, and 
then click Properties.

To delete a shortcut, drag it to the Recycle Bin. The 
original item will still exist on the disk where it is stored.
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“Send To” Menu Shortcuts

You can also add UNZIP95.EXE as a destination under the “Send To” 
command, which appears on the Windows Explorer “File” menu and the 
popup shortcut menu that appears when you RIGHT click the mouse on 
any file types. This is another way to manually unzip self-extracting Zip 
archives and avoid the potential of virus infections from files obtained 
through unknown third-parties and outside sources -- this method also 
avoids having to rename the self-extracting “EXE” file to one with a “ZIP”
extension.  

In the “Send To” folder, located in your Windows folder, you can create 
one or more shortcuts to UNZIP95.EXE to add “Send To” submenu 
destinations.  Follow these steps, to add a new submenu to the “Send 
To” menu:

1. Start Windows Explorer or My Computer, and 
locate the folder for the Windows directory.

2. Open the Windows directory folder.

3. Double-click the “Sendto” folder.

4. Click the “File” menu, point to “New,” and then 
click “Shortcut.”

5. Use the Create Shortcut wizard to add items to 
the submenu. 

Once a “Send To” shortcut has been created, follow these steps to 
quickly send Zip archive files to UnZIP95:

1. Use your right mouse button to click the file you 
want to send.

2. Point to Send To, and then click the destination.

Windows Registration Database
Some of the UnZIP95 features rely on information contained in Windows 
Registration Database, e.g., with respect the default location of Windows
WordPad and Quick View utilities.

Refer to the Microsoft Windows User Guide or Help files, for 
information on using the Windows Registration Database.
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GETTING MORE HELP

DISTRIBUTION DOCUMENTATION AND HELP 
FILES

FlashPoint Windows UnZIP95 distribution files provides several forms of 
help and instructions for the user.

Note:  This an edited or limited versions, of the official
UnZIP95 User’s Guide and UnZIP95 Windows Help

files, are included in the unregistered shareware,
evaluation version of UnZIP95, and may not be as

complete as the documentation provided with the full,
licensed and registered version of the product.

The UnZIP95 User's Guide provides the most detailed description of all 
UNZIP95 application features.  It consists of extensive text and graphics,
along with a detailed Table of Contents.  This guide is provided on disk, 
in Windows WordPad and Word for Windows compatible formats, and 
may be printed by the applicable programs.

The quickest form of on-line help is provided in the complete version of 
the FlashPoint’s UnZIP95 Windows Help file.  It provides in depth 
descriptions of all UNZIP95 application features, through hypertext 
cross-references and other standard and custom WinHelp features, and 
allows the user to search for a topic for quick instructions as to the usage
of a particular command or feature.

Note:   UnZIP95 registration, license and order
information, together with order forms, are contained in

the Product Catalog (ORDERME.DOC) file.

Order forms may also be printed directly from the
product help file (UNZIP95.HLP), located in the

Windows or Windows System directory.

VISIT FLASHPOINT’S WORLD WIDE WEB 
(WWW) SITE

FlashPoint Development now has a World Wide Web (WWW) site on the
Internet!  The site is located at:

http://members.aol.com/flashptdev

or use our backdoor, at:

http://ourworld.compuserve.com/
homepages/flashpoint_development
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The site is always under construction, in order to continually improve this
service  and  to  provide  information  and  product  support  for  both  our
existing and potential customers.  Through this service new or improved
product announcements, product support, downloads and useful tips will
be made available.

In  the  near  future,  we  also  hope to  provide  useful  FAQ  (Frequently
Asked Questions) files, updated User documentation, and what ever else
we can think of in the upcoming months.  So be sure to visit us, and tell
a friend or two.
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CONTACTING FLASHPOINT

VIA THE WORLD WIDE WEB (WWW)

FlashPoint Development can now be reached through the World Wide
Web (WWW).  The site is located at

http://members.aol.com/flashptdev

or use our backdoor, at:

http://ourworld.compuserve.com/
homepages/flashpoint_development

This service offers handy e-mail connections to FlashPoint,  as well as
new  or  improved  product  announcements,  product  support,  free
downloads, useful tips and links to other valuable services.

VIA THE INTERNET AND COMMERCIAL ONLINE 
SERVICES

FlashPoint Development and the product authors welcome e-mail via the
Internet and commercial online services, including America Online 
(AOL), CompuServe (CIS) and the Microsoft Network (MSN).  

The following e-mail addresses may be accessed directly, by subscribers
to the indicated services, or via the Internet and other Internet gateways 
(e.g.,  MCI Mail, AT&T Mail, Apple Link, Sprint Mail and other Internet 
services):

Service From/Via Address Mail To

Microsoft 
Network [msn]

Microsoft 
Network

FlashPoint

Internet flashpoint@msn.com

America Online
[AOL]

America Online FlashPtDev

Internet flashptdev@aol.com

CompuServe 
[CIS]

CompuServe 70771,1336

Internet 70771.1336@compuserve.com

Note that many online services, e.g., MCI Mail, A.T.&T. Mail, Apple Link,
Sprint Mail, are capable of directing mail through Internet gateways to 
the above Internet addresses; however, as each service may require 
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internal extensions to an address, each user should check with their 
service to verify the correct address format for sending mail to any of the
above services through an Internet gateway.

We strongly recommend that users and their companies, as Microsoft 
Windows and Windows95/NT users, consider the benefits and savings 
that are now provided through competitive and reasonably priced on-line 
and e-mail services such as Microsoft Network and America Online.  For
example, access to America Online is available through a custom 
Windows communications interface and Microsoft Network provides an 
advanced, integrated Windows interface for their service; each of these 
services's user interfaces are feature rich, have quality e-mail capabilities
and are provided by the service at no charge to their subscribers.

VIA LOCAL BULLETIN BOARD SYSTEMS (BBS)

FlashPoint Development and the authors may also be reached by 
modem, on a local Houston, Texas, bulletin board systems (BBS), where
unregistered copies of the most recent shareware releases of FlashPoint
applications are posted.

The  Ye Olde Bailey BBS, in Houston, Texas, can be accessed by 
calling (713) 520-1569 (Public Node) and (713) 520-9566 (Private Node).
Please note that access to the Private Nodes of these services generally
require payment of a membership fee; information on obtaining 
membership is available on the Public Nodes. 

The following e-mail addresses may be accessed directly, by subscribers
to the BBS, or via the Internet and other Internet gateways (e.g.,  MCI 
Mail, AT&T Mail, Apple Link, Sprint Mail and other Internet services):

Service From/Via Address Mail To

Ye Olde Bailey Ye Olde Bailey Richard Patterson

Internet richard.patterson@yob.com

Those interested in Microsoft Windows and other related topics may find 
these boards to be some of the best and most active in the Houston 
area.  In addition, most users will agree that the  Ye Olde Bailey BBS, is 
most likely one of the most complete and professionally run bulletin 
board systems in the country -- it is a Smartnet Regional Hub and 
supports Internet mail, UseNet, PC Pursuit, SmartNet, TexasNet and the
Annex.  

Please remember that these are independent boards, and are not run or 
operated by anyone affiliated with FlashPoint Development -- we are the 
guests of the systems' operators; therefore, please respect their rules 
and regulations.

Also note that FlashPoint Development and the authors do not check the
BBS for e-mail and messages on a daily basis, so responses are not as 
quick as directing mail through one of the aforementioned Internet or 
commercial online service addresses.
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ORDERING LICENSED COPIES OF 
UNZIP95

Information on ordering full, licensed copies of UnZIP95, together with 
the applicable order forms, can be found in the UnZIP95 Product 
Catalog (ORDERME.DOC) file.

Such information can also be located through UnZIP95’s “About” dialog 
panel controls, which provide access to UnZIP95’s Windows Help file 
(UNZIP95.HLP) -- order forms can also be printed directly from the help 
file.

Registration and order information, together with order forms, are now
contained in the Product Catalog (ORDERME.DOC) file.  In addition, the
ORDER_IU.DOC file, contains an Individual Use (Per Copy) License Order

Form, and the ORDER_MU.DOC file, contains an Multiple Use (Site) License
Order Form.  Each of these files are formatted in the Microsoft Word for

Windows 6.0 document format.

WordPad and non-Word 6.0 users may not be able to print order forms
(contained in the Product Catalog, ORDER_IU.DOC or ORDER_MU.DOC)
directly from their editor due to their Word 6.0 specific formatting.  Therefore,

order forms may also be printed directly from the product help file
(UNZIP95.HLP), located in the Windows or Windows System directory folder.
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LEGAL NOTICES

The software, documentation and related materials are furnished under 
license and nondisclosure agreements, and may be used, copied or 
distributed only in accordance with the terms of the applicable agreements.  
All materials are protected under various United States and international 
laws, including those related to copyright and trademark.

Unregistered, evaluation releases may be distributed through shareware 
channels for evaluation purposes only, provided same are distributed as a 
single package and without modification.

Registered versions may not be redistributed.  With the exception of fully 
paid site licenses, the software, documentation and related materials may 
only be used or copied, unless otherwise noted, by the original purchaser, 
who may only make one copy of the software for backup purposes.

Subject to the provisions concerning distribution of unregistered evaluation 
copies, no part of this manual or product may be reproduced or transmitted 
in any form or by any means, electronic or mechanical, including 
photocopying and recording, for any purpose other than the purchaser's 
personal use without the written permission of the author and copyright 
holder.

The software, documentation and related materials contain the latest 
information available at the time of publication; however, the software, 
documentation and related materials, including any information contained 
therein, are subject to change without notice.  The author and copyright 
holder retains all rights with respect to these materials, and is not obligated 
to develop future releases or to distribute future release, if any, through this 
or any other channel.

Neither Richard Patterson or FlashPoint Development offer any warranty, 
express or implied, regarding the accuracy, sufficiency, suitability or 
merchantability of the software or materials delivered herewith.  Users and 
distributors have the sole responsibility for evaluating, inspecting and testing 
all products, materials and services to their satisfaction, prior to their 
purchase or use.

All sales and purchases are subject to final approval and acceptance in 
Houston, Texas, and are only shipped FOB Houston, Texas.  Furthermore, 
all contracts, duties and obligations shall be deemed accepted, performed 
and completed in Houston, Texas, and governed by the laws of the State of 
Texas.  Jurisdiction and venue shall be exclusive and limited to the courts 
within Harris County, Texas.

Absent a tangible written and physically signed agreement to the contrary, 
dated subsequent to the date and time of this release, the terms and 
conditions of the licenses, representations and agreements contained in the 
software, documentation and related materials, herewith distributed, are 
exclusive, controlling and binding on all users, distributors, contractors and 
vendors of this product, together with their successors and assigns,  
notwithstanding any purported agreements, purchase orders, electronic 
communications or instruments to the contrary.

Notwithstanding the foregoing, those using these materials agree to and are 
bound by the terms and conditions contained therein, including all applicable
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license or nondisclosure agreements, and agree to accept same "AS IS" and
without warranty.  RICHARD PATTERSON AND FLASHPOINT 
DEVELOPMENT MAKE NO WARRANTIES, EXPRESS OR IMPLIED, IN 
THIS DOCUMENT, THE SOFTWARE OR ANY RELATED MATERIALS, 
AND SHALL NOT BE LIABLE FOR ANY USE OF SUCH BY ANY PARTY.

For further information and limitations, please refer to the applicable sections
of this and related documentation and files distributed with this product.

See also, the “License and Agreements” section of this document.

PROPRIETARY INFORMATION
The following, names, marks, logos, products and derivatives thereof, are 
intellectual property, servicemarks and trademarks of FlashPoint 
Development or Richard S. Patterson:

Alias Directories Windows Navigator
Completely Simple WinNAV
Escape and eScape WinNAV-CS
FlashNews! WinNAV32
FlashPoint WinNAV95
FlashPoint Windows WinNie
FPZIP WinQPrt
FPZIP32 WinQView
FPZIP95 WinSFX
FPZIPX WIZ
FPZIPX32 WIZiper
FPZIPX95 ZIP95
"It's FlashPoint WindowWare!" Zip Filer
The Navigator ZipNAV
NAV Zip Navigator
UnZIP-CS ZIPTools
UnZIP32 ZIPX
UnZIP95 ZIPX95

and other "Navigator," "WinQ" and "Flash" tools and utilities.

All others trade and service marks belong to their respective owners.

FlashPoint Development and its products are not affiliated with either David 
B. Gordon or FlashPoint, of Austin, Texas.

ACKNOWLEDGMENTS

Software, like most other things in life, are derivative products.  That is, each
new program or feature is often a new refinement of something that came 
before.  UnZIP95 is no different.

Although many deserve credit, all can not possibly be recognized.  So, to 
those omitted, we apologize, but still offer a thank you.

Of course, special thanks should be given to Phil Katz of PKWare, Inc., for 
originally developing the ZIP file format, and also a special thank you to 
SEA, for giving him the initiative to do so.

An additional thank you to Samuel H. Smith, who originally introduced us to 
the inner workings of the ZIP file format so many years ago, and kindly gave 
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us permission to use such knowledge in our original The Navigator, 
Windows Navigator ("WinNAV") and other archive products.  Also, a thank 
you to those members of Info-ZIP who further refined that knowledge.

Of course, thanks should also be given to those individuals who have helped
hook us on programming generally, by providing the knowledge and source 
code that gave us a working knowledge of what we should be doing and how
it might be accomplished, these include Charles Petzold, Andrew Schulman,
Jeffrey M. Richter, Mark Nelson, Mark Gamble, Richard Schnell and 
countless, countless more.

It should be noted that this product may incorporate code based on or 
derived from algorithms and procedures developed or distributed by the Info-
ZIP group and Samuel H. Smith.  Portions of the Info-ZIP compression 
sources are copyright (c) 1990-1993, by Mark Adler, Richard B. Wales, 
Jean-loup Gailly, Kai Uwe Rommel, Igor Mandrichenko and John Bush; 
portions of the Info-ZIP decompression sources were originally based on 
sources copyrighted (c) 1987-90, by Samuel H. Smith; other portions of the 
Info-Zip sources are public domain.

Many of the original ZIP sources, developed by Samuel H. Smith are 
available for download, at no charge, from his bulletin board system (BBS), 
"The Tool Shop," at (213) 389-5300.

The original Info-ZIP sources are available for download, at no charge, from 
many Internet sites, public bulletin board systems and on-line services.  
Registered users of this product may order copies from FlashPoint 
Development, for a small copying fee.

There are no extra or hidden charges resulting from the use, if any, of such 
code in this or any FlashPoint product.
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LICENSE AND AGREEMENTS

The following constitutes legal agreements between you (either an 
individual or an entity) as the Licensee and a distributor or end 
user of the product, and FlashPoint Development as Licensor.  If 
you do not agree to the terms of this Agreement, promptly remove 
from your system and destroy or return to FlashPoint Development
all copies of the software, any disks or media, and any 
accompanying items (including documentation, written materials 
or binders, other containers or media).

FLASHPOINT DEVELOPMENT LICENSE AGREEMENT

Licensee, by use, sale, purchase or distribution of the software, 
documentation or related materials, acknowledges and agrees to the 
following terms and conditions.

GRANT OF EVALUATION LICENSE.  FlashPoint Development grants 
you a limited, non-exclusive and non-transferable evaluation license 
which confers the right to make copies of the unregistered, shareware 
evaluation version of the software product, together with any 
accompanying documentation and related materials, herein sometimes 
referred to as the "product," solely for use at one location, for evaluation 
purposes only; the period of evaluation shall not exceed thirty (30) days 
from the date of its original installation and use.  The software and 
documentation shall not be copied, distributed or used for any other 
purpose.  Furthermore, you agree to destroy or erase all unregistered 
copies of the product upon the expiration of the thirty (30) day evaluation
period or upon request of FlashPoint Development, whichever occurs 
first.  You agree that you may not reverse engineer, decompile or 
disassemble the software.  Nothing herein shall be construed as a grant 
of any license to use or distribute any registered version of the product.

AVAILABILITY OF REGISTERED VERSIONS OF THE PRODUCT 
AND OTHER LICENSES.  All other licenses are prepaid only and 
subject to final acceptance and approval by FlashPoint Development in 
Houston, Texas.  Upon full payment of all applicable license fees to and 
written acceptance and approval by FlashPoint Development, Licensee 
shall be granted one or more of the following licenses:

1. Individual Use (Per Copy) Licenses.  Upon acceptance and 
approval by FlashPoint Development of Licensee's application or
order to purchase a registered individual use (per copy) license, 
whether direct or through a third-party, and subject to the terms 
and conditions of all applicable FlashPoint License Agreements 
and amendments thereof, which may be delivered with or 
contained in the registered software product and which are 
hereby incorporated by reference, FlashPoint Development will 
grant a perpetual individual use license, for the sole use by 
Licensee; such software license is limited to use exclusively by 
the Licensee.  This license is not transferable, and is limited to 
internal use and copying of not more than one copy of each 
contracted and prepaid licensed copy purchased by Licensee, 

FlashPont Development



UnZip95 55

i.e., the maximum users or machines for which the Licensee 
purchased the license.

2. Multiple Use (Site) Licenses.  Upon acceptance and approval 
by FlashPoint Development of Licensee's application or order to 
purchase a registered site license, whether direct or through a 
third-party, and subject to the terms and conditions of all 
applicable FlashPoint License Agreements and amendments 
thereof, which may be delivered with or contained in the 
registered software product and which are hereby incorporated 
by reference, FlashPoint Development will grant a perpetual 
multiple use or site license, for the sole use by Licensee; such 
software license is limited to use by the Licensee and its 
employees at their regular place of business or in the course and
scope of their employment,.  This license is not transferable, and
is limited to internal use and copying of the software by not more
than the number of contracted and prepaid licensed copies 
purchased by Licensee, i.e., the maximum users or machines for
which the Licensee purchased the license.

3. Required Distribution Licenses.  A prepaid, non-exclusive and
non-transferable Distribution License is required by an 
organization, company or government agency to use FlashPoint 
products and self-extracting archives and utilities created 
therewith, to facilitate the distribution of your data files and 
software to outside parties; to use such products and self-
extracting archives and utilities created therewith, within your 
organization, company or government agency (see, “Multiple 
Use (Site) Licenses”).  Distribution Licenses are granted and 
their respective license fees are set on a limited, case by case 
basis  Approval of such licenses require the prospective 
Licensee to first submit an Application for Distribution License to 
receive a quotation (see, “Distribution Licenses” and “Application
for Distribution License” topics of the product User's Guide and 
on-line help files, the provisions of which are hereby incorporated
by reference).

USE AND TRANSFER.  You may not rent, lease, sell, sublicense, 
outsource, assign or otherwise transfer the software, documentation or 
related materials, except pursuant to a written agreement with 
FlashPoint Development.  Notwithstanding or in addition to the foregoing:

1. Distribution of Unregistered Evaluation Versions of the 
Product.  You may distribute complete unregistered evaluation 
copies of the original software, documentation and related 
materials to third-parties, for the sole purpose of evaluation by 
them, provided such parties shall agree to be bound by the 
terms of this Agreement.  You may not charge more than a 
minimal fee, not to exceed $10.00, to cover the costs of media, 
distribution and handling or download of evaluation copies of the 
product, nor may you distribute same without clearly informing 
such third-parties that the software, documentation  and related 
materials have not been registered with FlashPoint Development
and are provided for the limited purpose of evaluation in 
accordance with the terms of this Agreement to which said third-
parties will be bound.  Under no circumstances will you use or 
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distribute only a portion of the software; you must provide a full 
and complete copy of the original software and documentation 
package.  

2. Other Limitations on Distribution and Use.  Use of all or part 
of the product, whether a registered or unregistered version, in 
the distribution of other software or for commercial purposes is 
prohibited, without securing a prepaid Distribution License 
directly from FlashPoint Development.

3. Distribution of Registered or Licensed Versions of the 
Product Prohibited.  You may not, for any purpose, distribute 
copies of registered or licensed versions of the software, 
documentation or related materials to any third-parties.

4. Other Prohibited Use and Distribution.   Repackaging, 
outsourcing, reverse engineering, decompiling, disassembly, 
sublicensing, leasing, assignment, reselling or distribution of the 
software in any manner not expressly authorized by a written 
and physically signed agreement with FlashPoint Development 
shall not be permitted under this agreement.

COPYRIGHT, TRADEMARKS, PATENTS AND INTELLECTUAL 
PROPERTY RIGHTS.  The software, documentation and related 
materials, together with all trademarks, patents and intellectual property 
rights contained or referenced therein, are owned by FlashPoint 
Development or Richard S. Patterson, and are protected by United 
States copyright laws and international treaty provisions.  Licensee, by 
use, sale, purchase or distribution of the software, documentation or 
related materials, acknowledges and agrees that FlashPoint 
Development and Richard S. Patterson are the exclusive owner of and 
retains all rights and interest in all of such copyrights, trademarks, 
patents and intellectual property rights, and that Licensee shall protect 
such property and rights and make no claim to same.  Furthermore, 
Licensee agrees to indemnify and hold harmless said owners for any and
all damages, arising under contract, tort or any other theory and 
including but not limited to loss of use, loss of profits, mental anguish 
and damages, including punitive and exemplary, resulting from 
confusion, infringement, libel, slander, disparagement, interference with 
economic advantage and business relationships, which may result from 
or be related to any conduct or claim of Licensee or the breach of any 
provision of this Agreement, including the use or distribution of such 
products, any third-party products and services, or the aforementioned 
copyright, trademark, patent and intellectual property rights.
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DISCLAIMER OF WARRANTY.  THIS SOFTWARE, 
DOCUMENTATION AND RELATED MATERIALS ARE PROVIDED "AS 
IS" WITHOUT WARRANTY OF ANY KIND.  FLASHPOINT 
DEVELOPMENT FURTHER DISCLAIMS ALL WARRANTIES, 
WHETHER EXPRESS OR IMPLIED, INCLUDING WITHOUT 
LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE OR AGAINST 
INFRINGEMENT.  THE ENTIRE RISK ARISING OUT OF USE, 
DISTRIBUTION OR PERFORMANCE OF THE SOFTWARE AND 
DOCUMENTATION REMAINS WITH YOU.  IN NO EVENT SHALL 
FLASHPOINT DEVELOPMENT OR ITS SUPPLIERS BE LIABLE FOR 
ANY DAMAGES WHATSOEVER (INCLUDING, WITHOUT 
LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, 
BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, 
LOSS OF DATA OR OTHER PECUNIARY LOSS) ARISING OUT OF 
THE USE OF OR INABILITY TO USE THE SOFTWARE OR 
DOCUMENTATION, EVEN IF FLASHPOINT DEVELOPMENT HAS 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  
BECAUSE SOME STATES DO NOT ALLOW THE EXCLUSION OR 
LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL 
DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.  In 
no event, however, shall Licensor's aggregate liability for damages ever 
exceed the actual price paid for the license to use the above designated 
software package, regardless of the form of any claim.

U.S. GOVERNMENT RESTRICTED AND LIMITED RIGHTS.  The 
software and documentation are provided with RESTRICTED AND 
LIMITED RIGHTS.  Use, duplication, or disclosure by the Government is
subject to restrictions and limitations as set forth in subparagraph (c)(1)
(ii) of The Rights in Technical Data and Computer Software clause at 
DFARS 252.227-7013 of subparagraphs (c)(i) and (2) of Commercial 
Computer Software -- Restricted Rights at 48 CFR 52.227-19, as 
applicable, and under other applicable law.  Manufacturer is FlashPoint 
Development, P. O. Box 270492, Houston, Texas  77277.

YOUR LIABILITY.  In the event you elect to use, sell, purchase or 
distribute any product, software, documentation or other materials, or all 
or any portion of any product, pursuant to or in violation of the terms of 
or proprietary interests set forth in this Agreement or related product or 
documentation, you agree to compensate FlashPoint Development for 
each copy of any product used or distributed at no less than three times 
the full retail price, and to reimburse, indemnify, hold harmless and 
defend FlashPoint Development for, from and against any damages, 
including punitive and exemplary, costs, claims or lawsuits, including 
attorneys' fees, that arise or result from the use and distribution of any 
product or materials.

GOVERNING LAW.  This Agreement is governed by and shall be 
construed and enforced in accordance with the laws of the State of 
Texas.  In any action arising under the terms or conditions of this license
agreement, jurisdiction and venue shall be proper as to all parties, only in
a State court located in Harris County, Texas; this provision shall be 
mandatory unless expressly prohibited by law, in which case it shall be 
considered to be permissive.  Any and all solicitations, sales or 
distributions of any FlashPoint product shall be deemed to have taken 
place in Harris County, Texas. for any purpose, including but not limited 
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to any sales, use or other taxes.  Under no circumstances shall any 
Licensee or other person or entity be authorized to take or take without 
authority any action that submits or purports to submit either FlashPoint 
Development, Richard S. Patterson or their successors, agents or 
assigns to the jurisdiction or taxing authority of any governmental agency
or tribunal other than those of or within the City of Houston, County of 
Harris, State of Texas.

Should you have any questions concerning this Agreement, or if you 
desire to contact FlashPoint Development for any reason, please write to
FlashPoint Development, P. O. Box 270492, Houston, Texas  77277.

Also see, the following topics in the Product Catalog 
(ORDERME.DOC), for additional information on:

“How to Order and License Applications”

“Registered User Benefits, Support and Feedback”

“General Information”

“Individual Use (Per Copy) Licenses”

   “Fees and Charges”

   “Order Forms -- Individual Use (Per Copy) Licenses”

“Multiple Use (Site) Licenses”

    “Fees and Charges”

    “Order Forms -- Multiple Use (Site) Licenses”
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INSTALLATION AND REMOVAL OF 
UNZIP95

FlashPoint Windows UnZIP95 should be installed using the custom 
installation program, SETUP.EXE; however, it is also possible to 
manually install the programs and default configuration.

The user may manually uninstall the application programs, or use 
various third-party uninstall utilities.

AUTOMATED INSTALLATION

To install this product, using the automated setup procedures, do the 
following:

Step 1 --

Close any running Windows Explorer (or "My Computer") windows.

The  setup  program  installs  a  new  Explorer  Shell  Extension  file
(UNZIP95.DLL), and if you are already running an old version of this DLL
it should be replaced with the new version.

If  the new DLL file  is  copied over a copy that  is  currently  in use by
Explorer, your system may become unstable and you may experience
some general protection or other system errors; this problem is cured, if
it occurs, by simply exiting and then restarting Windows.

Step 2 --

If  the distribution files you received are contained in a self-extracting
WinSFX  (tm)  zip  archive  file,  run  either  UNZIP95S.EXE  (if  you  are
installing an unregistered shareware, evaluation version of the product)
or  UNZIP95R.EXE  (if  you  are  installing  a  registered  version  of  the
product).   This  will  expand  all  installation  files  to  a  user  specified
temporary directory.

In Windows, you may run any EXE file by one of several methods, e.g.,
by double-clicking on the file's name in Explorer or File Manager, or by
using the "Run" command available in the Start Button Menu or in the
File Menu of Windows'  Program Manager,  File Manager,  or other file
management shell utility.

When the WinSFX file runs,  you will  be prompted for the name of  a
temporary  directory  to  which  the  product  installation  files  will  be
expanded -- after completion of a successful installation, you may delete
the files that were expanded to this directory.

Step 3 --

Run the FlashPoint Windows Setup program loader (SETUP.EXE).   
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This step is performed automatically by the FlashPoint WinSFX ™ self-
extracting  Zip  archive  file  (as  described  in  Step  2,  above),  if  the
distribution files have not been previously extracted.

The SETUP.EXE can be manually started under Windows, by several
methods, e.g., by double-clicking on the file's name in Explorer or File
Manager, or by using the "Run" command available in the Start Button
Menu or in the File Menu of Windows' Program Manager, File Manager,
or other shell utility.

Setup will  install,  if  required,  and start  the FlashPoint Windows Setup
Wizard.  The SETUP.EXE application is loaded automatically, in normal
installations, if you ran UNZIP95S.EXE or UNZIP95R.EXE

Step 4 --

The setup program will initially propose that the application be installed in
the Windows Directory; however, any other directory may be substituted.
If the directory does not exist, it will be created by the setup program.

UnZIP95 does not require that  this directory  be identified in the DOS
environment "PATH=" setting, as all program files are installed in either
the Windows or Windows System directory.

Answer any additional prompts that may display on your screen as the
Setup Wizard runs.  For example, if you already have an older version of
UnZIP95 on your system, you may be asked if  you want to overwrite
certain files -- you should anwer "YES" or "OK" to these prompts, and
allow the new files to overwrite the old.

Windows  will  refuse  to  let  the  Setup  program  overwrite  a  currently
loaded copy of the UNZIP95.DLL or any other file in use.  If this occurs,
Setup, at the conclusion of the Windows installation, will attempt to exit
to DOS to copy any remaining files from one or more temporary directory
files using a DOS batch file named  WINSTART.BAT, and then restart
Windows.
      
If, for any reason, Setup cannot fully install copies of all files, the user
may exit to DOS mode and manually copy each of the required files to
the  applicable  target  directory.   See,  the  UnZIP95  User’s  Guide
(UNZIP95.DOC) or the Windows Help file (UNZIP95.HLP), or review the
following section of  this file,  entitled “Uninstalling FlashPoint  Windows
UnZIP95,” for a description of where each file is installed.

To restart your computer in MS-DOS mode, (1) click the “Start” button,
(2) click “Shut Down” and (3) then click “Restart The Computer In MS-
DOS Mode.”

Step 5 --

Add the FlashPoint UnZIP95 application directory path to the "PATH="
statement in your DOS AUTOEXEC.BAT file, if the applications were not
installed  in  an  existing  directory  referenced  in  the  AUTOEXEC.BAT
"PATH=" statement.
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This step is not required if the default install settings were used, as all
program and help files were installed to either the Windows or Windows
System directory by default.

Step 6 --

It  is  recommended that  you exit  Windows,  reboot your computer and
then restart Windows, to insure that all new settings will take effect and
to force Windows Explorer to load or reload the UNZIP95.DLL module.

Step 7 --

Delete all files that were expanded to the temporary directory from which
the product was installed (see, Step 2, above).  If no files remain in the
directory, you may wish to also delete the directory.

This  step  is  not  required  if  you  installed  UnZIP95  from  a  floppy
distribution disk that contained fully expanded files, i.e., the distribution
files were not contained in a single WinSFX self-extracting  Zip archive
file.

Step 8 --

If  you click on the "UnZIP95 Help" icon in Explorer,  My Computer,  or
other  folder,  window  or  menu  item,  and  get  a  error  message  that
Windows cannot find the UNZIP95.HLP file, you will need to revise the
current target path name.

Generally, the target path problem can be corrected by (1) locating and
selecting the UNZIP95.HLP file in Windows Explorer (which should be in
the  Windows  or  Windows  System  folder/directory),  (2)  clicking  the
RIGHT mouse button and (3) selecting the "Properties" item from the
popup context menu.  When the Properties dialog is displayed, simply
delete the incorrect  path,  leaving only the filename "UNZIP95.HLP" --
this file is located in either the Windows or Windows System directory,
which  Windows   automatically  searches  (so  you  need not  enter  the
actual target directory), and click OK to close the dialog.

This  error  should  not  occur  if  Help  was  invoked  from  any  of  the
application  programs,  even  if  the  aforementioned  changes  were  not
made.

Step 9 --

User's should optimize their systems using the Windows file association
capabilities.

When internal  ZIP  file  members  are associated with  user  designated
applications,  FlashPoint  Windows  UnZIP95’s  advanced  “Properties”
dialog’s “Open,” “Print” and “View” buttons, with a simple click with the
mouse,  can  expand  and  load  the  selected  member  file  into  the
associated application automatically.

Refer to the applicable shell or file manager application's user manual or
the  Microsoft  Windows  User  Guide,  for  information  on  how  to
associate files.
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MANUAL INSTALLATION

UnZIP95 may be manually installed, by following these steps:

1. The application files (those ending with the file extension "EXE") 
and help files (those ending with the file extension "HLP" and 
“CNT”), which include the following files

fpzxx32.exe
unzip95.exe
unzip95.hlp
unzip95.cnt

may be copied to the Windows directory, the Windows System 
directory or any directory that is accessible through the DOS 
PATH setting.

2. The dynamic link libraries and resource files (those ending with 
the file extension "DLL"), which include the following files

unzip95.dll

should be copied to the Windows System directory.

Generally, they may also be copied to the Windows directory or 
any directory that is designated in the DOS PATH setting 
(including where the above *.EXE files were installed).  Note, 
however, that some systems and Windows configurations may 
produce various error messages with respect to not being able to
locate a file or dyna link, if these files are not placed in the 
Windows System directory.

3. Associate common file extension with the appropriate application
program.  See, the Microsoft Windows User's Guide, for 
instructions on how to associate or create file types.

4. Modify the applicable sections of the Windows Registration 
Database.  In Windows, you must edit the database file, using 
the Registration Info Editor (REGEDIT.EXE) program.  See, the 
Microsoft Windows User's Guide, for instructions on the 
Registration Database.

Its easier and safer, however, to just use the UNZIP95.REG 
files, which contains references to all lines that need to be added
to the Windows Registration Database.  These lines can be 
added by just “running” the UNZIP95.REG file -- this can be 
done via the Windows start menu or double-clicking on the file in
Windows Explorer, My Computer or File Manager.  Note, that 
other third-party and FlashPoint Windows applications and 
utilities, including FlashPoint Zip Navigator ("ZipNAV"), also rely 
on these database entries; thus, errors in entering this 
information can also disable other utilities (and even Windows 
itself).
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UNINSTALLING UNZIP95

To remove the UnZIP95 files and configurations from a user's system, 
simply reverse the manual installation steps, by removing the appropriate
settings from the Windows Registration Database and deleting the 
specified UNZIP95 files from the user's disk.

UnZIP95 may be manually uninstalled, by following these steps:

1. Delete the application files (those ending with the file extension 
"EXE") and the help files (those ending with the file extension 
"HLP"), from the user's system.  These files include the following
filenames:

fpzxx32.exe
unzip95.exe
unzip95.hlp
unzip95.cnt
unzip95.gid (created by Windows)

These files may be located in the Windows directory, the 
Windows System directory or a directory that is accessible 
through the DOS PATH setting.  Their exact location depends on
how the product was originally installed.

2. Delete the dynamic link libraries and resource files (those ending
with the file extension "DLL"), from the user's system.  These 
files include the following filenames:

unzip95.dll

These files may be located in the Windows directory, the 
Windows System directory or a directory that is accessible 
through the DOS PATH setting.  Their exact location depends on
how the product was originally installed.

3. Experienced users may modify applicable sections of the 
Registration Database, removing all references to "UnZIP95."  In
Windows, you must edit the database, using the Registration 
Info Editor (REGEDIT.EXE) program.  See, the Microsoft 
Windows User's Guide, for instructions on the Registration 
Database.

The UNZIP95.REG files contains references to all lines added to
the Windows Registration Database.  These lines may be 
deleted by experienced users using the REGEDIT applications,
search and delete capabilities.  Note, however, that other third-
party and FlashPoint Windows applications and utilities, 
including FlashPoint Zip Navigator ("ZipNAV"), also rely on these
database entries; thus, deleting these lines can also disable 
other utilities (and even Windows itself).
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Inexperienced users and those unconfortable with editing the 
registration database should simply ignore this step.  These 
entries add only a few bytes to the file size, consume no 
significant system resources, and have no effect once the 
aforementioned UnZIP95 are deleted.
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GLOSSARY

Associating Files -- Creating a file type or association is similar to 
associating a file in Windows version 3.1, but you can specify 
actions for more than just opening the file; for example, you can 
specify which program should be used for printing the document.

Close, Minimize, and Maximize buttons -- Every window has an    
(Close button) in the upper-right corner that you can click to 
close the window and quit the program.  The Minimize and 
Maximize buttons also have a new look.

Context Menus -- You can use your right mouse button to click any 
item and see a shortcut menu. This menu contains common 
commands that you can use on the item you clicked. For 
example, by clicking a file with your right mouse button, you can 
choose to open, copy, or delete it. Also, referred to as “popup” or
“shortcut” menus.

The Desktop -- When you start Windows, the large area you see is 
called the desktop. You can customize the desktop by adding 
shortcuts to your favorite programs, documents, and printers, 
and by changing its look to fit your mood and personality.  To 
adjust settings such as desktop color and background, use your 
right mouse button to click anywhere on the desktop, and then 
click Properties.

Directory -- Your documents and programs are stored in directories, 
which you can see in My Computer and Windows Explorer. In 
current versions of Windows, directories are now commonly 
referred to as folders.

Explorer -- In Windows Explorer, you can see both the hierarchy of 
folders on your computer and all the files and folders in each 
selected folder. This is especially useful for copying and moving 
files. You can open the folder that contains the file you want to 
move or copy, and then drag it to the folder you want to put it in. 
To find Windows Explorer, click the Start button, and then point 
to Programs.

File Directories or Folders -- Your documents and programs are 
stored in folders, which you can see in My Computer and 
Windows Explorer. In previous versions of Windows, folders 
were called directories.

File Extensions --  Most filenames have a file extension, but the 
extension may or may not be visible in Windows Explorer or My 
Computer, depending on the system configuration. To see all 
files and filename extensions

1 In My Computer or Windows Explorer, open the 
folder you want to look at.
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2 On the View menu, click Options.

3 Click the View tab, and then click Show All Files.
If you want to see all filename extensions, make 
sure the Hide MS-DOS File Extensions box is 
not checked.

File Name -- Under Windows 95, a filename can contain up to 255 
characters, including spaces, but it cannot contain any of the 
following characters:

\  / : * ? " < > |

Note, however, that other operating systems and environments 
are not the same, e.g., older versions of Windows and DOS are 
limited to filenames consisting of eight (8) characters, a period or
dot and a three (3) character filename extension.  Thus, care 
should be used in assigning names for files that will be 
transferred or used under other operating systems or 
environments.

File Path or Filespec-- The file path is a more direct way to describe 
where a file, such as a document or program, is located on your 
computer or network.   A file path or filespec includes the drive, 
folders, and subfolders that contain a file, in addition to the file's 
name.  Generally, a filename ends with a 3-letter "extension" 
that indicates what type of file it is. For example, a filename 
ending in .“.EXE” is a program, and a filename ending in .“.TXT” 
is a text file.

To specify the full filespec of a file --

1 Type the drive letter, followed by a colon (:) and 
backslash (\). 

2 Type the names of the folders and subfolders that 
contain the file. A backslash should precede each folder 
or subfolder name.

3 Type the name of the file. A backslash should precede 
the filename.  If you use filenames that contain spaces 
or exceed eight characters in length, enclose the path in 
quotation marks. 

In general usage, the terms “file path” and “filespec” are 
interchangeable with the terms “path” or “pathspec.”

File Types, Creating -- Creating a file type is similar to associating a 
file in Windows version 3.1, but you can specify actions for more 
than just opening the file; for example, you can specify which 
program should be used for printing the document.

Folder -- Your documents and programs are stored in folders, which 
you can see in My Computer and Windows Explorer. In previous
versions of Windows, folders were called directories.
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Long filenames -- You can now give any name to a file; you are not 
limited to eight characters with a three-character extension. You 
can even use spaces!

My Computer -- You can use My Computer desktop icon to quickly 
and easily see everything on your computer. Double-click the My
Computer icon on the desktop to browse through your files and 
folders.  Tip:  Add a “Windows Explorer” shortcut to your 
desktop, and try using it instead of the “My Computer” icon.

Notepad -- You can use the Windows Notepad program to create or 
edit text files that do not require formatting and are smaller than 
64K. Notepad opens and saves text in ASCII (text-only) format 
only. To create or edit files that require formatting or are larger 
than 64K, use WordPad. For information about how to use 
Notepad, click the Help menu in Notepad.

Network Neighborhood -- If you are using a network, the Network 
Neighborhood icon appears on your desktop.  Double-click it to 
browse through the computers in your workgroup and the 
computers on your entire network.

Path or Pathspec-- A path is a more direct way to describe where a 
file, such as a document or program, is located on your 
computer or network.   A path or pathspec includes the drive, 
folders, and subfolders that contain a file, in addition to the file's 
name.  Generally, a filename ends with a 3-letter "extension" 
that indicates what type of file it is. For example, a filename 
ending in .“.EXE” is a program, and a filename ending in .“.TXT” 
is a text file.

To specify a path --

1 Type the drive letter, followed by a colon (:) and 
backslash (\). 

2 Type the names of the folders and subfolders that 
contain the file. A backslash should precede each folder 
or subfolder name.

3 Type the name of the file. A backslash should precede 
the filename.  If you use filenames that contain spaces 
or exceed eight characters in length, enclose the path in 
quotation marks. 

In general usage, the terms “path” and “pathspec” are 
interchangeable with the terms “file path” or “filespec.”

Popup Menus -- You can use your right mouse button to click any 
item and see a shortcut menu. This menu contains common 
commands that you can use on the item you clicked. For 
example, by clicking a file with your right mouse button, you can 
choose to open, copy, or delete it. Also, referred to as “context” 
or “shortcut” menus.
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Properties -- When you want to view or change information about any
item, such as a document, program, folder, disk drive, or printer, 
you can look at its properties. Use the right mouse button to click
the item, and then click Properties on the menu.  For MS-DOS-
based programs, you no longer need to create and 
modify .“*.PIF” files; you just modify the properties for the 
program.

Quick Viewers -- A set of utilities provided with Windows 95 that 
provide the capability to view documents that were created with 
popular Windows-based programs without starting the actual 
program.  If Quick View is not available, either your file type is 
not supported by it, or it is not installed on your computer. Look 
up "installing, Windows components" in the Microsoft Windows 
Help Index.

Shortcut Menus -- You can use your right mouse button to click any 
item and see a shortcut menu. This menu contains common 
commands that you can use on the item you clicked. For 
example, by clicking a file with your right mouse button, you can 
choose to open, copy, or delete it. Also, referred to as “popup” or
“context” menus.

Start button and taskbar -- At the bottom of your screen is the 
taskbar. It contains the Start button, which you can use to 
quickly start a program or to find a file. It's also the fastest way 
to get Help.  When you open a program, document or window, a 
button appears on the taskbar. You can use this button to 
quickly switch between the windows you have open.

Taskbar and buttons -- At the bottom of your screen is the taskbar. It
contains the Start button, which you can use to quickly start a 
program or to find a file. It's also the fastest way to get Help.  
When you open a program, document, or window, a button 
appears on the taskbar. You can use this button to quickly 
switch between the windows you have open.

Windows Explorer -- In Windows Explorer, you can see both the 
hierarchy of folders on your computer and all the files and folders
in each selected folder. This is especially useful for copying and 
moving files. You can open the folder that contains the file you 
want to move or copy, and then drag it to the folder you want to 
put it in.  To find Windows Explorer, click the Start button, and 
then point to Programs.  Tip:  Add a Windows Explorer shortcut 
to your desktop and use it instead of the “My Computer” icon.

WordPad -- WordPad is a text editor for short documents. You can 
format documents in WordPad with various font and paragraph 
styles, and you can use WordPad to import and view files 
created using other editors and wordprocessors.  For information
about how to use WordPad, click the Help menu in WordPad.  If 
WordPad is not installed on your computer, look up "installing, 
Windows components" or “installing, WordPad” in the Microsoft 
Windows Help Index.
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